NOTICE OF MEETING
Tuesday, January 19, 2021, 3:30 to 5:00 p.m.
Email Ashley Welch at awelch@ucsd.edu to obtain the Zoom link.

ORDER OF BUSINESS

(1) Minutes of Meeting of December 1, 2020

(2-7) Announcements

(a) Chair Steven Constable

(b) Chancellor Pradeep Khosla
   Executive Vice Chancellor Elizabeth Simmons

(c) Research Integrity
   Sandra Brown, Vice Chancellor for Research

(d) Office of the Ombuds
   John Armijo, Director and Ombudsperson
   Nicholas Raichart, Associate Ombudsperson

(8) Special Orders

(a) Consent Calendar [none]

(9) Reports of Special Committees [none]

(10) Reports of Standing Committees

(a) Educational Policy Committee, Geoffrey Cook, Chair
    Five Limited-Term Exceptions for Winter and Spring Quarters 2021
    to San Diego Divisional Senate Regulations 500 Grading Policy,
    501 Adding and Dropping Courses and Withdrawals, and
    505 Repetition of Courses
    • A limited-term exception for Winter and Spring Quarters 2021 to SD Regulation
      500.D.2 to extend the deadline to change grading option (Letter or Pass/Not Pass
      grades) from the end of the fourth week to the end of the tenth week of instruction for
      undergraduate students.
    • A limited-term exception for Winter and Spring Quarters 2021 to SD Regulation
      500.E.6 to extend the deadline to change grading option (Letter or
      Satisfactory/Unsatisfactory grades) from the beginning of the quarter (end of the
      fourth week, in practice) to the end of the tenth week of instruction for graduate
      students.
    • A limited-term exception for Winter and Spring Quarters 2021 to SD Regulations
      501.B and 501.C to extend the deadline to drop a class or withdraw from the quarter

[Any member of the Academic Senate may attend and make motions at meetings of the Representative Assembly; however, only members of the Representative Assembly may second motions and vote.]
with a "W" grade from the end of the sixth week to the end of the seventh week of instruction for undergraduate students.

- A limited-term exception for Winter and Spring Quarters 2021 to SD Regulation 500.D.1 to exclude P/NP grades earned from the 25% limit on the number of courses that may be completed on a P/NP basis and allow students not in good academic standing to enroll in courses for a P/NP grade.
- A limited-term exception for Winter and Spring Quarters 2021 to SD Regulation 505.B to allow students to repeat courses with the P/NP or S/U grade option if previously taken for a letter grade.

(11) Reports of Faculties

(a) Warren College Faculty, Marisa Abrajano, Provost

- Proposal to Amend Senate Manual Appendix 5.4, Bylaws of the Faculty of Earl Warren College

(12) Petitions of Students [none]

(13) Unfinished Business [none]

(14) New Business
SAN DIEGO DIVISIONAL REPRESENTATIVE ASSEMBLY MEETING ZOOM ATTENDANCE INSTRUCTIONS

A Logging into the Meeting

1 Senate Members who are not Representative Assembly Members & Invited Guests

RSVP prior to the start of the meeting to obtain the meeting link: email Ashley Welch at awelch@ucsd.edu.

2 Representative Assembly Members

Representative Assembly members are not required to RSVP for the meeting. The Senate Office will distribute a meeting link to all members via email. Contact Ashley Welch at awelch@ucsd.edu if you are an Assembly Representative and you did not receive the meeting link.

B Meeting Participation

When you join the meeting, you will be placed in a waiting room until the meeting host admits you into the meeting. Please log in 15 minutes early (at 3:15) to ensure that you are admitted to the meeting before it starts (at 3:30).

Your audio will be disabled by default when you enter the meeting; please refrain from turning on your microphone unless called upon by the Chair.

During the meeting, the Chair will call for questions and comments at the appropriate intervals, as usual, and you may raise your electronic hand in Zoom to request to speak. However, it is anticipated that discussion will be limited due to the Zoom format of the meeting. Thus, participants are strongly encouraged to review the meeting materials in advance of the meeting and send questions to academicsenateoffice@ucsd.edu with the agenda topic number or proposal title in the subject line of the email, by Friday morning, January 15th. Your questions will be shared with the presenters so that they may address them in their presentations, and thus help to mitigate the challenge presented by a large Zoom meeting.

Following discussion of items that require a vote, a poll will pop-up on your screen to vote. As with in-person meetings, only Representative Assembly members may vote. Primary Representatives and Alternate Representatives should coordinate their attendance and voting for this meeting. Both may attend; however, Alternate Representatives may only vote in the absence of the Primary Representative. Please coordinate who will attend and cast votes in advance of the meeting.

C Additional Zoom Meeting Note

Please use your actual first and last name with your Zoom account; the Senate Office must be able to establish your identity in order to admit you into a Representative Assembly meeting.

Instructions on how to manage your Zoom profile can be found here: https://support.zoom.us/hc/en-us/articles/201363203-Customizing-your-Profile.
### 2020-2021 Representative Assembly

<table>
<thead>
<tr>
<th>Name</th>
<th>Representing</th>
</tr>
</thead>
<tbody>
<tr>
<td>AARONS, SARAH MIRANDA</td>
<td>ALTERNATE REPRESENTATIVE - SIO</td>
</tr>
<tr>
<td>ACHIM, CRISTIAN</td>
<td>PRIMARY REPRESENTATIVE - PSYCHIATRY</td>
</tr>
<tr>
<td>ACKERMAN, FARRELL</td>
<td>ALTERNATE REPRESENTATIVE - LINGUISTICS</td>
</tr>
<tr>
<td>ADAMS, JOSEPH A</td>
<td>ALTERNATE REPRESENTATIVE - PHARMACOLOGY</td>
</tr>
<tr>
<td>ADLER, STEVEN</td>
<td>PRIMARY REPRESENTATIVE - EMERITUS FACULTY</td>
</tr>
<tr>
<td>AKIWATE, GAUTAM</td>
<td>ALTERNATE GRADUATE STUDENT ADVISOR</td>
</tr>
<tr>
<td>ALFORD, MATTHEW H</td>
<td>PRIMARY REPRESENTATIVE - SIO</td>
</tr>
<tr>
<td>ALGAZE, GUILLERMO</td>
<td>PRIMARY REPRESENTATIVE - ANTHROPOLOGY</td>
</tr>
<tr>
<td>ALI, MOHAMMAD KAZIM</td>
<td>PRIMARY REPRESENTATIVE - LITERATURE</td>
</tr>
<tr>
<td>APPELBRAUM, MARK I</td>
<td>ALTERNATE REPRESENTATIVE - EMERITUS FACULTY</td>
</tr>
<tr>
<td>AVERITT, RICHARD</td>
<td>PRIMARY REPRESENTATIVE - PHYSICS</td>
</tr>
<tr>
<td>BARNER, DAVID A</td>
<td>PRIMARY REPRESENTATIVE - PSYCHOLOGY</td>
</tr>
<tr>
<td>BARRICELLI, MARC ALEXANDER</td>
<td>PRIMARY REPRESENTATIVE - THEATRE &amp; DANCE</td>
</tr>
<tr>
<td>BLANCO, JOHN D</td>
<td>ALTERNATE REPRESENTATIVE - MUIR COLLEGE</td>
</tr>
<tr>
<td>BLANCO, JOHN D</td>
<td>PRIMARY REPRESENTATIVE - LITERATURE</td>
</tr>
<tr>
<td>BLOSS, CINNAMON SUE</td>
<td>PRIMARY REPRESENTATIVE - FAMILY &amp; PREVENTIVE MEDICINE</td>
</tr>
<tr>
<td>BOLAR, DIVYA SANAM</td>
<td>PRIMARY REPRESENTATIVE - RADIOLOGY</td>
</tr>
<tr>
<td>BOOMHOWER, JUDSON P</td>
<td>ALTERNATE REPRESENTATIVE - ECONOMICS</td>
</tr>
<tr>
<td>BRENNER, DAVID ALLEN</td>
<td>VICE CHANCELLOR - HEALTH SCIENCES</td>
</tr>
<tr>
<td>BRIGGS, STEVEN PAUL</td>
<td>ALTERNATE REPRESENTATIVE - BIOLOGICAL SCIENCES</td>
</tr>
<tr>
<td>BROWN, SANDRA A</td>
<td>VICE CHANCELLOR - RESEARCH AFFAIRS</td>
</tr>
<tr>
<td>BUCKLEY, JILL CHRISTINE</td>
<td>ALTERNATE REPRESENTATIVE - UROLOGY</td>
</tr>
<tr>
<td>BURELLE, JULIE SARA</td>
<td>ALTERNATE REPRESENTATIVE - THEATRE &amp; DANCE</td>
</tr>
<tr>
<td>BURNLEY, JENNIFER A</td>
<td>CHAIR, DIVERSITY &amp; EQUITY</td>
</tr>
<tr>
<td>CHAO, LIN</td>
<td>PRIMARY REPRESENTATIVE - BIOLOGICAL SCIENCES</td>
</tr>
<tr>
<td>CHAUDHURI, KAMALIKA</td>
<td>PRIMARY REPRESENTATIVE - CSE</td>
</tr>
<tr>
<td>CHEN, JIUN-SHYAN</td>
<td>PRIMARY REPRESENTATIVE - STRUCTURAL ENGINEERING</td>
</tr>
<tr>
<td>CHI, NAI-WEN</td>
<td>PRIMARY REPRESENTATIVE - MEDICINE</td>
</tr>
<tr>
<td>CHO, ERICA R</td>
<td>PRIMARY REPRESENTATIVE - VISUAL ARTS</td>
</tr>
<tr>
<td>CLANCY, LIAM P</td>
<td>PRIMARY REPRESENTATIVE - REVELLE COLLEGE</td>
</tr>
<tr>
<td>CLARKE, SHERICE NICOLE</td>
<td>ALTERNATE REPRESENTATIVE - EDUCATION STUDIES</td>
</tr>
<tr>
<td>COHEN, SHANA R</td>
<td>ALTERNATE REPRESENTATIVE - ROOSEVELT COLLEGE</td>
</tr>
<tr>
<td>CONSTABLE, STEVEN C</td>
<td>CHAIR OF DIVISION</td>
</tr>
<tr>
<td>Name</td>
<td>Role</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Cook, Geoffrey William</td>
<td>Chair</td>
</tr>
<tr>
<td>Cook-Anderson, Heidi Leigh</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Cooke, James Edward</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Corbett, Kevin Daniel</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Corr, Mary P</td>
<td>2019/2020 Chair of Division</td>
</tr>
<tr>
<td>Coulson, Seana</td>
<td>Member, Academic Assembly</td>
</tr>
<tr>
<td>Dameff, Christian Jordan</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Deak, Gedeon O</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Deutsch, Alin Bernard</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Dewaard, Andrew Michael</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Dorrestein, Pieter C</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Dorschner, Robert A</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Du, Songzi</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Dubnov, Shlomo</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Edington, Claire Ellen</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>El-Tayeb, Fatima</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Ellis, Ronald Joseph</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Fadare, Oluwole</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Fadlon, Yizhak</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Ferree, Karen E</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Ferreira, Victor S</td>
<td>Chair, Research</td>
</tr>
<tr>
<td>Figueroa, Joshua S</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Fitzsimmons, Patrick J</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Fleischer, Jason G</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Forbes, Douglas Jane</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Frank, Ross H</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Friedman, Rick Adam</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Fuste, Jose Ignacio</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Galperin, Michael</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Garfein, Richard S</td>
<td>Alternate Representative</td>
</tr>
<tr>
<td>Gharibian, Deena</td>
<td>Primary Undergraduate Student Advisor</td>
</tr>
<tr>
<td>Ghosh, Pradipta</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Gneemy, Ayelet</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Golan, Tal</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Golden, James William</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Goodall, Grant</td>
<td>Primary Representative</td>
</tr>
<tr>
<td>Name</td>
<td>Position</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>GRINSTEIN, BENJAMIN</td>
<td>PRIMARY REPRESENTATIVE - PHYSICS</td>
</tr>
<tr>
<td>HALGREN, ERIC</td>
<td>PRIMARY REPRESENTATIVE - NEUROSCIENCES</td>
</tr>
<tr>
<td>HALL, DREW A</td>
<td>ALTERNATE REPRESENTATIVE - WARREN COLLEGE</td>
</tr>
<tr>
<td>HALPAIN, SHELLEY L</td>
<td>MEMBER, ACADEMIC COUNCIL</td>
</tr>
<tr>
<td>HARGENS, ALAN R</td>
<td>PRIMARY REPRESENTATIVE - ORTHOPAEDICS</td>
</tr>
<tr>
<td>HERMANN, THOMAS C</td>
<td>ALTERNATE REPRESENTATIVE - SIXTH COLLEGE</td>
</tr>
<tr>
<td>HICKMAN, DAVID</td>
<td>PRIMARY UNDERGRADUATE STUDENT ADVISOR</td>
</tr>
<tr>
<td>HILDEBRAND, JOHN A</td>
<td>PRIMARY REPRESENTATIVE - SIO</td>
</tr>
<tr>
<td>HOPKINS, MEGAN BETH</td>
<td>ALTERNATE REPRESENTATIVE - MARSHALL COLLEGE</td>
</tr>
<tr>
<td>HORGAN, SANTIAGO</td>
<td>PRIMARY REPRESENTATIVE - SURGERY</td>
</tr>
<tr>
<td>HOSTON, GERMAINE A</td>
<td>PRIMARY REPRESENTATIVE - POLITICAL SCIENCE</td>
</tr>
<tr>
<td>INTRILIGATOR, KENNETH A</td>
<td>ALTERNATE REPRESENTATIVE - PHYSICS</td>
</tr>
<tr>
<td>JAIN, MOHIT</td>
<td>ALTERNATE REPRESENTATIVE - MEDICINE</td>
</tr>
<tr>
<td>JAVIDI, TARA</td>
<td>VICE CHAIR OF DIVISION</td>
</tr>
<tr>
<td>JENKINS, JANIS H</td>
<td>CHAIR, CAMPUS &amp; COMMUNITY ENVIRONMENT</td>
</tr>
<tr>
<td>JOHNSON, SARA</td>
<td>ALTERNATE REPRESENTATIVE - LITERATURE</td>
</tr>
<tr>
<td>KARIS, ALECK</td>
<td>CHAIR, ACADEMIC PERSONNEL</td>
</tr>
<tr>
<td>KEHLER, ANDREW SCOTT</td>
<td>PRIMARY REPRESENTATIVE - LINGUISTICS</td>
</tr>
<tr>
<td>KENYATTA, KAMAU</td>
<td>ALTERNATE REPRESENTATIVE - MUSIC</td>
</tr>
<tr>
<td>KERES, DUSAN</td>
<td>ALTERNATE REPRESENTATIVE - PHYSICS</td>
</tr>
<tr>
<td>KHOSLA, PRADEEP K</td>
<td>CHANCELLOR</td>
</tr>
<tr>
<td>KIDMAN, SHAWNA F</td>
<td>ALTERNATE REPRESENTATIVE - COMMUNICATIONS</td>
</tr>
<tr>
<td>KLEINFELD, DAVID</td>
<td>PRIMARY REPRESENTATIVE - PHYSICS</td>
</tr>
<tr>
<td>KRASHEVINNIKOV, SERGEI</td>
<td>PRIMARY REPRESENTATIVE - MAE</td>
</tr>
<tr>
<td>KREMEN, WILLIAM S</td>
<td>PRIMARY REPRESENTATIVE - PSYCHIATRY</td>
</tr>
<tr>
<td>LAL, RATNESHWAR</td>
<td>PRIMARY REPRESENTATIVE - MAE</td>
</tr>
<tr>
<td>LAMPLAND, MARTHA</td>
<td>ALTERNATE REPRESENTATIVE - SOCIOLOGY</td>
</tr>
<tr>
<td>LAUBERTH, SHANNON MARIE</td>
<td>PRIMARY REPRESENTATIVE - REVELLE COLLEGE</td>
</tr>
<tr>
<td>LEFFERT, HYAM LERNER</td>
<td>PRIMARY REPRESENTATIVE - PHARMACOLOGY</td>
</tr>
<tr>
<td>LEINEN, MARGARET S</td>
<td>VICE CHANCELLOR - MARINE SCIENCES</td>
</tr>
<tr>
<td>LESLIE, MATTHEW</td>
<td>PRIMARY REPRESENTATIVE - MUSIC</td>
</tr>
<tr>
<td>LIANG, LEI</td>
<td>CHAIR, COMMITTEE ON COMMITTEES</td>
</tr>
<tr>
<td>LIAU, JOY</td>
<td>ALTERNATE REPRESENTATIVE - RADIOLOGY</td>
</tr>
<tr>
<td>LO, YU-HWA</td>
<td>PRIMARY REPRESENTATIVE - ECE</td>
</tr>
<tr>
<td>LYONS, ELIZABETH DEIRDRE</td>
<td>PRIMARY REPRESENTATIVE - GLOBAL POLICY AND STRATEGY</td>
</tr>
<tr>
<td>MALI, PRASHANT GULAB RAM</td>
<td>PRIMARY REPRESENTATIVE - BIOENGINEERING</td>
</tr>
<tr>
<td>Name</td>
<td>Position</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>MAMAS, CHRISTOFOROS</td>
<td>PRIMARY REPRESENTATIVE - EDUCATION STUDIES</td>
</tr>
<tr>
<td>MANGOLTE, BABETTE MARIE</td>
<td>ALTERNATE REPRESENTATIVE - VISUAL ARTS</td>
</tr>
<tr>
<td>MARTIN, ISAAC WILLIAM</td>
<td>PRIMARY REPRESENTATIVE - URBAN STUDIES &amp; PLANNING</td>
</tr>
<tr>
<td>MARTINEZ DIAZ, SONIA</td>
<td>PRIMARY REPRESENTATIVE - ROOSEVELT COLLEGE</td>
</tr>
<tr>
<td>MASUDA, KOICHI</td>
<td>ALTERNATE REPRESENTATIVE - ORTHOPAEDICS</td>
</tr>
<tr>
<td>MAX, JEFFREY EDWIN</td>
<td>ALTERNATE REPRESENTATIVE - PSYCHIATRY</td>
</tr>
<tr>
<td>MAZUMDAR, ARYA</td>
<td>PRIMARY REPRESENTATIVE - HALICIOGLU DATA SCIENCE INST</td>
</tr>
<tr>
<td>MCKENZIE, CRAIG RM</td>
<td>ALTERNATE REPRESENTATIVE - PSYCHOLOGY</td>
</tr>
<tr>
<td>MCEANEaney, William Michael</td>
<td>ALTERNATE REPRESENTATIVE - MAE</td>
</tr>
<tr>
<td>MEKEEL, KRISTIN LEIGH</td>
<td>PRIMARY REPRESENTATIVE - SURGERY</td>
</tr>
<tr>
<td>MEL, STEPHANIE</td>
<td>MEMBER, ACADEMIC ASSEMBLY</td>
</tr>
<tr>
<td>MEYER, DAVID A</td>
<td>PRIMARY REPRESENTATIVE - MATHEMATICS</td>
</tr>
<tr>
<td>MEYER, URSULA</td>
<td>ALTERNATE REPRESENTATIVE - WARREN COLLEGE</td>
</tr>
<tr>
<td>MEYERS, MARC ANDRE</td>
<td>ALTERNATE REPRESENTATIVE - NANOENGINEERING</td>
</tr>
<tr>
<td>MISRA, KANISHKA</td>
<td>ALTERNATE REPRESENTATIVE - RADY SCHOOL OF MANAGEMENT</td>
</tr>
<tr>
<td>MOMPER, JEREMIAH D</td>
<td>PRIMARY REPRESENTATIVE - SSPPS</td>
</tr>
<tr>
<td>MOOKHERJEA, SHAYAN</td>
<td>ALTERNATE REPRESENTATIVE - ECE</td>
</tr>
<tr>
<td>MUSEUS, SAMUEL DAVID</td>
<td>ALTERNATE REPRESENTATIVE - MUIR COLLEGE</td>
</tr>
<tr>
<td>NAOI, MEGUMI</td>
<td>ALTERNATE REPRESENTATIVE - POLITICAL SCIENCE</td>
</tr>
<tr>
<td>NELLIS, GARETH HB</td>
<td>ALTERNATE REPRESENTATIVE - REVELLE COLLEGE</td>
</tr>
<tr>
<td>NEWSOME, ELIZABETH ANN</td>
<td>ALTERNATE REPRESENTATIVE - VISUAL ARTS</td>
</tr>
<tr>
<td>NG, KWAI HANG</td>
<td>CHAIR, PLANNING &amp; BUDGET</td>
</tr>
<tr>
<td>NI, KAIXUAN</td>
<td>ALTERNATE REPRESENTATIVE - PHYSICS</td>
</tr>
<tr>
<td>NUDLEMAN, ERIC DANIEL</td>
<td>PRIMARY REPRESENTATIVE - OPHTHALMOLOGY</td>
</tr>
<tr>
<td>O'CONNOR, JOSEPH M</td>
<td>PRIMARY REPRESENTATIVE - CHEMISTRY &amp; BIOCHEMISTRY</td>
</tr>
<tr>
<td>OPAKIEWICZ, JUSTIN PAUL</td>
<td>PRIMARY REPRESENTATIVE - NANOENGINEERING</td>
</tr>
<tr>
<td>OPREA, DRAGOS N</td>
<td>PRIMARY REPRESENTATIVE - MATHEMATICS</td>
</tr>
<tr>
<td>OWENS, MELINDA TSAO-YING</td>
<td>PRIMARY REPRESENTATIVE - WARREN COLLEGE</td>
</tr>
<tr>
<td>PARSONS, J KELLOGG</td>
<td>PRIMARY REPRESENTATIVE - UROLOGY</td>
</tr>
<tr>
<td>PATEL, SHAISTA</td>
<td>ALTERNATE REPRESENTATIVE - ROOSEVELT COLLEGE</td>
</tr>
<tr>
<td>PATTERSON, PATRICK H</td>
<td>PRIMARY REPRESENTATIVE - HISTORY</td>
</tr>
<tr>
<td>PIERCE, KAREN L</td>
<td>PRIMARY REPRESENTATIVE - NEUROSCIENCES</td>
</tr>
<tr>
<td>PITT, RICHARD NORRIS</td>
<td>PRIMARY REPRESENTATIVE - SIXTH COLLEGE</td>
</tr>
<tr>
<td>PLANT, REBECCA JO</td>
<td>PRIMARY REPRESENTATIVE - MUIR COLLEGE</td>
</tr>
<tr>
<td>POLITIS, DIMITRIS</td>
<td>ALTERNATE REPRESENTATIVE - HALICIOGLU DATA SCIENCE INST</td>
</tr>
<tr>
<td>POMEROY, ROBERT S</td>
<td>ALTERNATE REPRESENTATIVE - SEVENTH COLLEGE</td>
</tr>
<tr>
<td>Name</td>
<td>Role</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>PORTER, GEORGE M</td>
<td>PRIMARY REPRESENTATIVE - SEVENTH COLLEGE</td>
</tr>
<tr>
<td>POSAKONY, JAMES WILLIAM</td>
<td>CHAIR, PRIVILEGE &amp; TENURE</td>
</tr>
<tr>
<td>POWELL, LORA</td>
<td>ALTERNATE REPRESENTATIVE - THEATRE &amp; DANCE</td>
</tr>
<tr>
<td>PRATHER, LAUREN R</td>
<td>ALTERNATE REPRESENTATIVE - GLOBAL POLICY AND STRATEGY</td>
</tr>
<tr>
<td>RADIC, STOJAN</td>
<td>PRIMARY REPRESENTATIVE - ECE</td>
</tr>
<tr>
<td>RISSMAN, ROBERT A</td>
<td>ALTERNATE REPRESENTATIVE - NEUROSCIENCES</td>
</tr>
<tr>
<td>ROBBINS, SHIRA L</td>
<td>ALTERNATE REPRESENTATIVE - OPHTHALMOLOGY</td>
</tr>
<tr>
<td>RONA-TAS, AKOS</td>
<td>PRIMARY REPRESENTATIVE - SOCIOLOGY</td>
</tr>
<tr>
<td>ROSE, JORDAN M</td>
<td>PRIMARY REPRESENTATIVE - VISUAL ARTS</td>
</tr>
<tr>
<td>RUSSELL, LYNN MONICA</td>
<td>CHAIR, GRADUATE COUNCIL</td>
</tr>
<tr>
<td>SCHNABL, BERND</td>
<td>PRIMARY REPRESENTATIVE - MEDICINE</td>
</tr>
<tr>
<td>SCHUCKIT, MARC A</td>
<td>ALTERNATE REPRESENTATIVE - PSYCHIATRY</td>
</tr>
<tr>
<td>SEBAT, JONATHAN LADD</td>
<td>PRIMARY REPRESENTATIVE - PSYCHIATRY</td>
</tr>
<tr>
<td>SEIBERT, TYLER MICHAEL</td>
<td>PRIMARY REPRESENTATIVE - RADIATION MEDICINE &amp; APPLIED SCIENCES</td>
</tr>
<tr>
<td>SEN, GEORGE L</td>
<td>PRIMARY REPRESENTATIVE - DERMATOLOGY</td>
</tr>
<tr>
<td>SESHADRI, KALYANASUNDARAM</td>
<td>PRIMARY REPRESENTATIVE - MARSHALL COLLEGE</td>
</tr>
<tr>
<td>SHEIKH, FARAH</td>
<td>ALTERNATE REPRESENTATIVE - MEDICINE</td>
</tr>
<tr>
<td>SHER, GILA</td>
<td>PRIMARY REPRESENTATIVE - PHILOSOPHY</td>
</tr>
<tr>
<td>SHUBAYEV, VERONICA I</td>
<td>PRIMARY REPRESENTATIVE - ANESTHESIOLOGY</td>
</tr>
<tr>
<td>SIGURDSON, CHRISTINA J</td>
<td>ALTERNATE REPRESENTATIVE - PATHOLOGY</td>
</tr>
<tr>
<td>SIMMONS, ELIZABETH H</td>
<td>EXECUTIVE VICE CHANCELLOR - ACADEMIC AFFAIRS</td>
</tr>
<tr>
<td>SINHA, SHANTANU</td>
<td>CHAIR, FACULTY WELFARE</td>
</tr>
<tr>
<td>STRASSER, ULRIKE</td>
<td>PRIMARY REPRESENTATIVE - ROOSEVELT COLLEGE</td>
</tr>
<tr>
<td>SUAREZ, JOSE R</td>
<td>ALTERNATE REPRESENTATIVE - FAMILY &amp; PREVENTIVE MEDICINE</td>
</tr>
<tr>
<td>TALKE, FRANK E</td>
<td>ALTERNATE REPRESENTATIVE - MAE</td>
</tr>
<tr>
<td>TAPERT, SUSAN FRANCES</td>
<td>MEMBER, ACADEMIC COUNCIL</td>
</tr>
<tr>
<td>TAUBER, MICHAEL J</td>
<td>ALTERNATE REPRESENTATIVE - MARSHALL COLLEGE</td>
</tr>
<tr>
<td>TAUR, YUAN</td>
<td>ALTERNATE REPRESENTATIVE - ECE</td>
</tr>
<tr>
<td>TERANES, JANE L</td>
<td>CHAIR, UNDERGRADUATE COUNCIL</td>
</tr>
<tr>
<td>THOMPSON, WESLEY KURT</td>
<td>PRIMARY REPRESENTATIVE - FAMILY &amp; PREVENTIVE MEDICINE</td>
</tr>
<tr>
<td>TOLLEY, CLINTON R</td>
<td>ALTERNATE REPRESENTATIVE - PHILOSOPHY</td>
</tr>
<tr>
<td>TOOR, NAVTEJ SINGH</td>
<td>ALTERNATE REPRESENTATIVE - CHEMISTRY &amp; BIOCHEMISTRY</td>
</tr>
<tr>
<td>TRONZO, WILLIAM L</td>
<td>ALTERNATE REPRESENTATIVE - REVELLE COLLEGE</td>
</tr>
<tr>
<td>TSAMPRAS, GEORGIOS</td>
<td>ALTERNATE REPRESENTATIVE - STRUCTURAL ENGINEERING</td>
</tr>
<tr>
<td>VAN ALLEN, EMILY JOYCE</td>
<td>PRIMARY REPRESENTATIVE - SIO</td>
</tr>
<tr>
<td>VARNER, JUDITH A</td>
<td>ALTERNATE REPRESENTATIVE - PATHOLOGY</td>
</tr>
<tr>
<td>Name</td>
<td>Position</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>VILKE, GARY MICHAEL</td>
<td>PRIMARY REPRESENTATIVE - EMERGENCY MEDICINE</td>
</tr>
<tr>
<td>VOGL, TOM SAUL</td>
<td>PRIMARY REPRESENTATIVE - SEVENTH COLLEGE</td>
</tr>
<tr>
<td>WANG, EDWARD J</td>
<td>ALTERTATE REPRESENTATIVE - SEVENTH COLLEGE</td>
</tr>
<tr>
<td>WANG, SHIZHEN</td>
<td>PRIMARY REPRESENTATIVE - PATHOLOGY</td>
</tr>
<tr>
<td>WANG, VICTOR</td>
<td>PRIMARY GRADUATE STUDENT ADVISOR</td>
</tr>
<tr>
<td>WASTAL, CARRIE KING</td>
<td>CHAIR, ADMISSIONS</td>
</tr>
<tr>
<td>WATSON, DEBORAH</td>
<td>ALTERTATE REPRESENTATIVE - SURGERY</td>
</tr>
<tr>
<td>WIDENER, DANIEL L</td>
<td>MEMBER, ACADEMIC ASSEMBLY (F)</td>
</tr>
<tr>
<td>WILKINSON, MILES FROME</td>
<td>PRIMARY REPRESENTATIVE - OBSTETRICS, GYNECOLOGY, &amp; REPRODUCTIVE SCIENCES</td>
</tr>
<tr>
<td>WUTHRICH, KASPAR</td>
<td>ALTERTATE REPRESENTATIVE - ECONOMICS</td>
</tr>
<tr>
<td>XIA, HAIJUN</td>
<td>ALTERTATE REPRESENTATIVE - COGNITIVE SCIENCE</td>
</tr>
<tr>
<td>ZEIDAN, FADEL</td>
<td>ALTERTATE REPRESENTATIVE - ANESTHESIOLOGY</td>
</tr>
<tr>
<td>ZHONG, SHENG</td>
<td>ALTERTATE REPRESENTATIVE - BIOENGINEERING</td>
</tr>
<tr>
<td>ZLATOS, ANDREJ</td>
<td>ALTERTATE REPRESENTATIVE - MATHEMATICS</td>
</tr>
</tbody>
</table>
Chair Constable called the meeting to order. A quorum was present (see attached attendance sheet), along with other Academic Senate members and guests. Chair Constable welcomed everyone to the second Representative Assembly meeting of the 2020-2021 academic year. Chair Constable reviewed the Academic Senate Bylaws governing membership, privileges of the floor, and voting.

MINUTES OF THE MEETING ON OCTOBER 13, 2020
The October 13, 2020 meeting minutes were approved as submitted.

The agenda was reordered to move agenda item 11(b), the proposal to establish a Department of Neurobiology, next.

Health Sciences Faculty Council, Elizabeth Winzeler, Chair; Alexander Khalessi, Professor of Surgery, Radiology and Neurosciences. Proposal to establish a Department of Neurological Surgery.

Chair Constable introduced HSFC Chair Winzeler and Professor Khalessi. Professor Khalessi provided an overview of the proposal and the three-year process to develop it. See page 122 of the meeting materials, and page 82 of the presentation slides. The clinical side has already been converted to a department and this proposal will convert the academic side. Department status will help with recruitment and retention, and with philanthropic efforts. HSF Chair Winzeler made a formal motion for approval of the proposal to establish a Department of Neurological Surgery. Because the motion was made on behalf of a Senate Committee, no second was required. Senate Chair Constable opened the floor to questions and discussion. There being none, Chair Constable called for a vote on the proposal. The proposal was approved by a majority vote.

ANNOUNCEMENTS BY THE CHAIR OF THE DIVISION

Chair Constable described the Divisional and UC Senate response to the proposed UC Curtailment Program, which called for a combination of enforced vacation and pay cuts across all UC campuses. The “curtailment" concept, rather than furloughs, had been proposed because Regents Standing Order 100.4 requires a declaration of extreme financial emergency before furloughs can be implemented, and that could not be declared due to UC’s liquidity as a result of low-interest borrowing in response to the budget crisis. The San Diego Divisional Senate joined all of the other UC Divisional Senates in opposition to the program. Eight San Diego Divisional Senate committees responded at short notice and produced written responses, which Senate Council consolidated into a Divisional opinion that went to the UC systemwide Academic Council. All other UC Divisions did the same. The uniformity of the responses across the UC Divisions was impressive. Campuses with vastly different financial situations came to the same conclusions -- the proposed curtailment program was not going to save enough money given the
huge negative impact on morale, and a one size fits all approach to the various campus situations was not appropriate. The systemwide Senate sent a 118 page memo to President Drake opposing the curtailment proposal, and on October 28th UC Academic Council gave voice to these opinions in a meeting with President Drake and Provost Brown. In a fine example of shared governance, the Senate's voice was heard, and last week President Drake announced a jobs protection plan that gives campuses agency to act independently. Chair Constable thanked the Senate committees and the 75 faculty voices that made a difference, and also acknowledge the role that the Chancellors played.

[For more information see UC Senate Response to the Proposed UC Curtailment Program.]

**CHANCELLOR PRADEEP KHOSLA REMARKS**

The Chancellor addressed UC San Diego’s finances and response to the pandemic. The campus budget, which totals $6B is composed of multiple sources. The operating budget consists of Core Funding, Externally Restricted Funding (Contract & Grants and Gift Income) and Separate Enterprises (the Health System and Auxiliaries). Only the $1.5B Core budget gets allocated by the campus. The Core budget is composed primarily of four sources – California State Funds, Resident Tuition and Fees, Non-Resident Tuition and Fees, Contracts & Grants Overhead, and Other Revenue. Spending on compensation is 70% of the Core budget. Academic Affairs, Health Sciences and Marine sciences receive 73% of the Core budget, and the figure is 77% when Research and Student Affairs are included. The impact of the COVID pandemic on the Core budget has been primarily recurring. The impact on Auxiliaries has been primarily one-time. Because the impact on the Core budget has been primarily recurring, the response has been structural (a compensation freeze and permanent budget cuts), in addition to the deferral of capital projects. Because the impact on the Auxiliaries was mostly one-time, the response has been an operating loan, efficiencies and reduced spending. The campus was proactive early, in the spring. A hiring freeze was implemented to avoid lay-offs and workforce reductions were achieved primarily through vacancies/attrition. The state budget cut is severe but there were no program cuts. Fall enrollment was at a record high. The goal is to maintain academic excellence and keep investment in the mission going. The Senate’s response to the proposed UC Curtailment Program helped to provide the Chancellors, who wanted authority to customize each campus’ response to the budget crisis, the flexibility they needed.

The Return to Learn (RTL) Program gave confidence to parents and students. The three pillars of the program are (1) Viral Detection, (2) Intervention, and (3) Risk Mitigation. Viral Detection includes testing, environmental monitoring, data modeling and molecular sequencing. Intervention includes contract tracing, exposure notification, case isolation, and County surveillance. Risk Mitigation includes face covering/distancing, structural reconfiguration, cleaning and sanitation, and airflow reconfiguration. RTL has resulted in a very low (less than half of one percent) 7-day on-campus student test positivity rate. Only 50 students tested positive since October 1, despite a 9,300 student population in residence on campus. Many of the positive cases are off-campus students. The UC San Diego testing capacity is the best in the system. One positive case can be detected out of hundreds of students. The Chancellor noted the work of Professor Natasha Martin, who developed very precise models, and acknowledged
the significant work of many other faculty members. More than 100 people came together to build the program.

See page 1 of the presentation slides.

**EXECUTIVE VICE CHANCELLOR ELIZABETH SIMMONS REMARKS**

EVC Simmons further discussed the RTL Program. Both the education and research missions of the campus are strong. The Senate and the Administration collaborated, and the campus’ unified response made a difference according to students and parents. Enrollment remained full during the spring quarter, summer enrollment was up 50%, and fall enrollment is at a record high with more than 40,000 students enrolled in remote and hybrid classes. The Fire Marshal approved teaching in outside tents. The faculty had not done a lot of remote teaching, but now there is more interest in R courses. There is a Senate Administration workgroup on distance education. The faculty are doing amazing research. The campus received a record $1.45B in research awards last fiscal year, and first quarter proposal submissions are up 62%. Many proposals are COVID-related. UC San Diego is also advising and consulting with San Diego County and other government entities, businesses, and non-profits. As one example, the work of the Amaro lab won an award. The EVC thanked the faculty and their teams for their education and research accomplishments.

[For more information see Return to Learn.]

**UC SAN DIEGO HEALTH SYSTEM CEO PATTY MAYSENT REMARKS**

CEO Maysent reported on the Health System’s COVID-19 readiness. On 11/30/20, the average daily census was 663, and there were only 5 ICU beds available. San Diego County hospitalizations now exceed the numbers from the spring. The modeling provided by Professor Natasha Martin has proved to be accurate. The Pfizer vaccine requires 2 doses 21 days apart. Distribution is expected to begin in December. The Moderna vaccine requires 2 doses, 28 days apart. Distribution of the Moderna vaccine is expected to begin shortly after the Pfizer distribution begins. The first phase will be healthcare workers and residents of long-term care facilities. Essential workers will follow, and then adults with high-risk medical conditions and adults over 65. UC San Diego Health is prepared and has the infrastructure to distribute the vaccines.

A member asked what should be expected with students leaving the campus during the break to travel. That is an unknown. A member asked for clarification on how far the curves run into the future and how the data is used. The curve runs 2-2.5 weeks in the future and is used to determine what are our triggers to cancel procedures to open up capacity, to plan for surges. A member asked if the models take into account interventions, such as closing restaurants, gyms and churches. Predictions are worst-case; however, Professor Martin’s modeling has proved be accurate. A member asked whether college professors are included in the definition of educators within the hierarchy of who will receive the vaccine and when. That is not known. A member asked what will happen if a frontline worker does not want the vaccine. There will be an option to opt out.
The Chancellor suggested that there be a townhall devoted to this topic.

See page 16 of the presentation slides.

**SPECIAL ORDERS**

Consent Calendar
The Bylaws of the San Diego Divisional Senate call for two elected members of the Representative Assembly to serve as at-large members on the Senate Council. Alternate Assembly members are not eligible for this service. Two Assembly members have been nominated by Senate Council and have agreed to serve if confirmed by Representative Assembly: Ross Frank (Associate Professor, Ethnic Studies) and Andrew Kehler (Professor, Linguistics). There being no objections, the appointments were approved.

**REPORTS OF SPECIAL COMMITTEES** [None]

**REPORTS OF STANDING COMMITTEES**

Graduate Council, Lynn Russell, Chair; and Stephen Hedrick, Professor, Division of Biological Sciences - Molecular Biology. Proposal to Establish PhD Specialization in Immunology, Division of Biological Sciences and Biomedical Sciences Graduate Program.

Chair Constable introduced GC Chair Russell and Professor Hedrick. Professor Hedrick provided an overview of the proposal. See page 100 of the meeting materials. The specialization will make the Immunology program more competitive, attracting graduate students who currently often do not discover the program until rotations. GC Chair Russell made a formal motion for approval of the proposal to establish a PhD Specialization in Immunology, Division of Biological Sciences and Biomedical Sciences Graduate Program. Because the motion was made on behalf of a Senate Committee, no second was required. Senate Chair Constable opened the floor to questions and discussion. There being none, Chair Constable called for a vote on the proposal. The proposal was approved by a unanimous vote.

Graduate Council, Lynn Russell, Chair; Uri Gneezy, Professor, Rady School of Management. Proposal to Amend San Diego Divisional Senate Regulation 703, Requirements for the Master of Finance Degree.

Chair Constable introduced GC Chair Russell and Professor Gneezy. Professor Gneezy provided an overview of the proposal. See page 102 of the meeting materials. The proposal will permit students to take more quantitative electives. GC Chair Russell made a formal motion for approval of the proposal to amend San Diego Divisional Senate Regulation 703, Requirements for the Master of Finance Degree. Because the motion was made on behalf of a Senate Committee, no second was required. Senate Chair Constable opened the floor to questions and discussion. There being none, Chair Constable called for a vote on the proposal. The proposal was approved by a majority vote.
Representative Assembly Minutes
December 1, 2020
Page 5

Graduate Council, Lynn Russell, Chair; Dimitris Politis, Professor, Mathematics and Associate Director, HDSI. Proposal to Establish MS in Data Science, Halicioğlu Data Science Institute.

Chair Constable introduced GC Chair Russell and Professor Politis. Professor Politis provided an overview of the proposal. See page 105 of the meeting materials, and page 25 of the presentation slides. A high demand is anticipated for this program, which will provide the foundational coursework to enable student with different backgrounds to be admitted. GC Chair Russell made a formal motion for approval of the proposal to establish a MS in Data Science, Halicioğlu Data Science Institute. Because the motion was made on behalf of a Senate Committee, no second was required. Senate Chair Constable opened the floor to questions and discussion. A member asked how the new degree program will be coordinated with the biostatistics program, and how it is different. There are other Masters programs in the same vein (e.g. math, health). HDSI will be a more of a general program, versus specialized. They are open to coordinating. HDSI faculty are faculty in other departments. A member asked if there was researched involved in the degree program, and if there is research, what proportion was focused on coursework versus research. The program will not require research, but students will have a thesis option. Masters students pay out of their own pocket; they are not funded by faculty. Chair Constable called for a vote on the proposal. The proposal was approved by a majority vote.

Graduate Council, Lynn Russell, Chair; Leo Porter, Associate Teaching Professor, Department of Computer Science and Engineering; and Jingbo Shang, Assistant Professor, Department of Computer Science and Engineering & HSDI. Proposal to Establish Master of Data Science (online), Halicioğlu Data Science Institute.

Chair Constable introduced GC Chair Russel and Professors Porter and Shang. Professors Porter and Shang provided an overview of the proposal. See page 107 of the meeting materials, and page 44 of the presentation slides. The proposed program is an online Masters aimed at working professionals, and builds on the existing in-person program. GC Chair Russell made a formal motion for the approval of the proposal to establish a Master of Data Science (online), Halicioğlu Data Science Institute. Because the motion was made on behalf of a Senate Committee, no second was required. Senate Chair Constable opened the floor to questions and discussion. A member asked if the unit requirements are different/lower than the in-person program. The required units (40) are the same. Chair Constable called for a vote on the proposal. The proposal was approved by a majority vote.

Educational Policy Committee, Geoffrey Cook, Chair. Proposal to Amend Senate Manual Appendix II, UCSD Policy on Integrity of Scholarship.

Chair Constable introduced EPC Chair Cook. EPC Chair Cook provided an overview of the proposal. See page 108 of the meeting materials, and page 78 of the presentation slides. The changes, identified by the Academic Integrity Office, are relatively minor but important to maintain academic integrity. EPC Chair Cook made a formal motion for the approval of the proposal to amend Senate Manual Appendix II, UCSD Policy on Integrity of Scholarship. Because the motion was made on behalf of a Senate Committee, no second was required. Senate Chair Constable opened the floor to questions and discussion. A member asked whether a
student could retroactively change to P/NP if they are not found responsible for violating the AI policy. If the student is held not responsible through an AI Review I or II, the matter shall be dismissed without further action against the student and the student shall be permitted either to complete the course without prejudice (based on their originally selected grading option) or to retroactively withdraw from it without indication on the student’s transcript. Chair Constable called for a vote on the proposal. The proposal was approved by a majority vote.

REPORTS OF FACULTIES


Chair Constable introduced Provost Carver. Provost Carver provided an overview of the proposal. See page 118 of the meeting materials. The faculty proposed the changes to better align with other colleges and current practices. Provost Carver made a formal motion for the approval of the proposal to amend Senate Manual Appendix 5.3, Bylaws of Thurgood Marshall College. Because the motion was made on behalf of a Senate Committee, no second was required. Senate Chair Constable opened the floor to questions and discussion. There being none, Chair Constable called for a vote on the proposal. The proposal was approved by a majority vote.

Health Sciences Faculty Council, Elizabeth Winzeler, Chair; Alexander Khalessi, Professor of Surgery, Radiology and Neurosciences. Proposal to establish a Department of Neurological Surgery.

See above.

SIO Faculty, Helen Fricker, Chair. A Motion on the UCOP Curtailment Proposal Submitted for Discussion/Vote.

Chair Constable introduced SIO Faculty Chair Fricker and referred to the meeting materials, page 369. The motion was withdrawn.

PETITIONS OF STUDENTS  [None]

UNFINISHED BUSINESS  [None]

NEW BUSINESS  [None]

Chair Constable called for any new business. There being none, the meeting was adjourned at 5:13 p.m.

Recorded by Ray Rodriguez, Senate Director
EX OFFICIO MEMBERS

☒ CONSTABLE, STEVEN C  CHAIR, SAN DIEGO DIVISION
☒ JAVIDI, TARA  VICE CHAIR, SAN DIEGO DIVISION
☐ MACKIE, GERALD LEE  PARLIAMENTARIAN, SAN DIEGO DIVISION
☒ KHOSLA, PRADEEP K  CHANCELLOR, UC SAN DIEGO
☒ SIMMONS, ELIZABETH H  EXECUTIVE VICE CHANCELLOR, ACADEMIC AFFAIRS
☐ BRENNER, DAVID ALLEN  VICE CHANCELLOR, HEALTH SCIENCES
☐ LEINEN, MARGARET S  VICE CHANCELLOR, MARINE SCIENCES
☒ BROWN, SANDRA A  VICE CHANCELLOR, RESEARCH AFFAIRS
☒ CORR, MARIPAT  IMMEDIATE PAST CHAIR, SAN DIEGO DIVISION
☐ KARIS, ALECK  CHAIR, ACADEMIC PERSONNEL
☒ COOK, GEOFFREY WILLIAM  CHAIR, EDUCATIONAL POLICY
☒ SINHA, SHANTANU  CHAIR, FACULTY WELFARE
☐ TERANES, JANE  CHAIR, UNDERGRADUATE COUNCIL
☒ LIANG, LEI  CHAIR, COMMITTEE ON COMMITTEES
☐ FERREIRA, VICTOR S  CHAIR, RESEARCH
☐ NG, KWAI HANG  CHAIR, PLANNING & BUDGET
☐ JENKINS, JANIS H  CHAIR, CAMPUS & COMMUNITY ENVIRONMENT
☐ WASTAL, CARRIE KING  CHAIR, ADMISSIONS
☐ BURNEY, JENNIFER A  CHAIR, DIVERSITY & EQUIT
☒ RUSSELL, LYNN MONICA  CHAIR, GRADUATE COUNCIL
☒ POSAKONY, JAMES WILLIAM  CHAIR, PRIVILEGE & TENURE
☐ HALPAIN, SHELLEY L  MEMBER, ACADEMIC COUNCIL
☒ TAPERT, SUSAN FRANCES  MEMBER, ACADEMIC COUNCIL
☐ COULSON, SEANA  SENIOR REPRESENTATIVE, ACADEMIC ASSEMBLY
☐ MEL, STEPHANIE  SENIOR REPRESENTATIVE, ACADEMIC ASSEMBLY
ELECTED MEMBERS & ALTERNATES

SAN DIEGO DIVISION
☐ COULSON, SEANA
  Primary Representative
☐ WIDENER, DANIEL L
  Primary Representative
☐ MEL, STEPHANIE
  Primary Representative

MARSHALL COLLEGE
☐ DEAK, GEDEON O
  Primary Representative
☒ SESHADRI, KALYANASUNDARAM
  Primary Representative
  Alternate Representative
☐ HOPKINS, MEGAN BETH
  Alternate Representative
☐ TAUBER, MICHAEL J
  Alternate Representative

MUIR COLLEGE
☐ BLANCO, JOHN D
  Primary Representative
☒ COOKE, JAMES
  Primary Representative
  Alternate Representative
☐ PLANT, REBECCA JO
  Alternate Representative
☐ MUSEAU, SAM
  Alternate Representative

REVELLE COLLEGE
☒ CLANCY, LIAM P
  Primary Representative
☒ LAUBERTH, SHANNON MARIE
  Primary Representative
  Alternate Representative
☐ TRONZO, WILLIAM L
  Alternate Representative
☐ NELLIS, GARETH HB
  Alternate Representative

ROOSEVELT COLLEGE
☐ MARTINEZ DIAZ, SONIA
  Primary Representative
☒ STRASSER, ULRIKE
  Primary Representative
  Alternate Representative
☐ COHEN, SHANA R
  Alternate Representative
☐ PATEL, SHAISTA
  Alternate Representative

SIXTH COLLEGE
☒ PITT, RICHARD
  Primary Representative
☐ GOLAN, TAL
  Primary Representative
  Alternate Representative
☐ DUBNOV, SHLOMO
  Alternate Representative
☐ HERMANN, THOMAS
  Alternate Representative

WARREN COLLEGE
☒ GOODALL, GRANT
  Primary Representative
☒ OWENS, MELINDA TSAO-YING
  Primary Representative

EMERITUS FACULTY
☐ POWELL, HENRY C
  Primary Representative
☒ ADLER, STEVEN
  Alternate Representative

ANESTHESIOLOGY
☐ SHUBAYEV, VERONICA I
  Primary Representative
☐ ZEIDAN, FADEL
  Alternate Representative
<table>
<thead>
<tr>
<th>Department</th>
<th>Representative(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ANTHROPOLOGY</strong></td>
<td>□ ALGAZE, GUILLERMO</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td><strong>BIOENGINEERING</strong></td>
<td>□ MALI, PRASHANT GULAB RAM</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ ZHONG, SHENG</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td><strong>BIOLOGICAL SCIENCES</strong></td>
<td>□ CHAO, LIN</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ BRIGGS, STEVEN PAUL</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td></td>
<td>□ GOLDEN, JAMES WILLIAM</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ FORBES, DOUGLASS JANE</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td><strong>CELLULAR &amp; MOLECULAR MEDICINE</strong></td>
<td>□ GHOSH, PRADIPTA</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ CORBETT, KEVIN DANIEL</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td><strong>CHEMISTRY &amp; BIOCHEMISTRY</strong></td>
<td>□ FIGUEROA, JOSHUA S</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ GALPERIN, MICHAEL</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td></td>
<td>□ O’CONNOR, JOSEPH M</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td><strong>COGNITIVE SCIENCE</strong></td>
<td>□ FLEISCHER, JASON G</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ XIA, HAIJUN</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td><strong>COMMUNICATIONS</strong></td>
<td>□ DEWAARD, ANDREW MICHAEL</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ KIDMAN, SHAWNA F</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td><strong>CSE</strong></td>
<td>□ CHAUDHURI, KAMALIKA</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ DEUTSCH, ALIN BERNARD</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td><strong>DERMATOLOGY</strong></td>
<td>□ SEN, GEORGE L</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ DORSCHNER, ROBERT A</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td><strong>ECE</strong></td>
<td>□ LO, YU-HWA</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ MOOKHERJEA, SHAYAN</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
<tr>
<td></td>
<td>□ RADIC, STOJAN</td>
</tr>
<tr>
<td></td>
<td>□ Primary Representative</td>
</tr>
<tr>
<td></td>
<td>□ TAUR, YUAN</td>
</tr>
<tr>
<td></td>
<td>□ Alternate Representative</td>
</tr>
</tbody>
</table>
ECONOMICS
☒ DU, SONGZI
Primary Representative
☒ FADLON, YIZHAK
Primary Representative
☐ BOOMHOWER, JUDSON P
Alternate Representative
☐ WUTHRICH, KASPAR
Alternate Representative

EDUCATION STUDIES
☒ MAMAS, CHRISTOFOROS
Primary Representative
☐ CLARKE, SHERICE NICOLE
Alternate Representative

EMERGENCY MEDICINE
☒ VILKE, GARY MICHAEL
Primary Representative
☐ DAMEFF, CHRISTIAN JORDAN
Alternate Representative

ETHNIC STUDIES
☐ FRANK, ROSS H
Primary Representative
☒ FUSTE, JOSE IGNACIO
Alternate Representative

FAMILY & PREVENTIVE MEDICINE
☐ BLOSS, CINNAMON SUE
Primary Representative
☒ THOMPSON, WESLEY KURT
Primary Representative
☐ GARFEIN, RICHARD S
Alternate Representative
☐ SUAREZ, JOSE R
Alternate Representative

GLOBAL POLICY AND STRATEGY
☐ LYONS, ELIZABETH DEIRDRE
Primary Representative

HISTORY
☒ EDINGTON, CLAIRE ELLEN
Primary Representative
☒ PATTERSON, PATRICK H
Primary Representative

LINGUISTICS
☒ KEHLER, ANDREW SCOTT
Primary Representative
☐ ACKERMAN, FARRELL
Alternate Representative

LITERATURE
☒ ALI, MOHAMMAD KAZIM
Primary Representative
☐ BLANCO, JOHN D
Primary Representative
☐ EL-TAYEB, FATIMA
Alternate Representative

MAE
☒ KRASHENINNIKOV, SERGEI
Primary Representative
☐ MCENEANEY, WILLIAM MICHAEL
Alternate Representative
☐ TALKE, FRANK E
Alternate Representative
☐ LAL, RATNESHWAR
Primary Representative
MATHEMATICS
☒ OPREA, DRAGOS N
   Primary Representative
☒ MEYER, DAVID A
   Primary Representative
☒ FITZSIMMONS, PATRICK J
   Alternate Representative
☒ ZLATOS, ANDREJ
   Alternate Representative

MEDICINE
☐ CHI, NAI-WEN
   Primary Representative
☒ SCHNABL, BERND
   Primary Representative
☐ JAIN, MOHIT
   Alternate Representative
☐ SHEIKH, FARAH
   Alternate Representative

MUSIC
☒ LESLIE, MATTHEW
   Primary Representative
☐ KENYATTA, KAMAU
   Alternate Representative

NANOENGINEERING
☐ OPAATKIEWICZ, JUSTIN PAUL
   Primary Representative
☐ MEYERS, MARC ANDRE
   Alternate Representative

NEUROSCIENCES
☐ HALGREN, ERIC
   Primary Representative
☐ PIERCE, KAREN L
   Primary Representative
☐ ELLIS, RONALD JOSEPH
   Alternate Representative
☐ RISSMAN, ROBERT A
   Alternate Representative

OBSTETRICS, GYNECOLOGY, & REPRODUCTIVE SCIENCES
☒ WILKINSON, MILES FROME
   Primary Representative
☐ COOK-ANDERSEN, HEIDI
   Alternate Representative

OPHTHALMOLOGY
☐ NUDLEMAN, ERIC
   Primary Representative
☐ ROBBINS, SHIRA L
   Alternate Representative

ORTHOPAEDICS
☒ HARGENS, ALAN R
   Primary Representative
☐ MASUDA, KOICHI
   Alternate Representative

PATHOLOGY
☒ FADARE, OLUWOLE
   Primary Representative
☒ WANG, SHIZHEN
   Primary Representative
☒ VARNER, JUDITH A
   Alternate Representative
☐ SIGURDSON, CHRISTINA J
   Alternate Representative

PHARMACOLOGY
☒ LEFFERT, HYAM LERNER
   Primary Representative
☐ ADAMS, JOSEPH A
   Alternate Representative

PHILOSOPHY
☒ SHER, GILA
   Primary Representative
☐ TOLLEY, CLINTON R
   Alternate Representative
PHYSICS
☒ KIEINFELD, DAVID
   Primary Representative

☒ AVERITT, RICHARD
   Primary Representative

☒ GRINSTEIN, BENJAMIN
   Primary Representative

☐ KERES, DUSAN, NI, KAIXUAN
   Alternate Representative

☒ INTRILIGATOR, KENNETH A
   Alternate Representative

POLITICAL SCIENCE
☒ HOSTON, GERMAINE A
   Primary Representative

☐ NAIÖ, MEGUMI
   Alternate Representative

☒ FERREE, KAREN E
   Primary Representative

PSYCHIATRY
☒ SEBAT, JONATHAN LADD
   Primary Representative

☐ MAX, JEFFREY EDWIN
   Alternate Representative

☒ KRE Men, WILLIAM S
   Primary Representative

☐ SCHUCKIT, MARC A
   Alternate Representative

☒ ACHIM, CHRISTIAN
   Primary Representative

PSYCHOLOGY
☒ BARNER, DAVID A
   Primary Representative

☐ MC KENZIE, CRAIG RM
   Alternate Representative

RADIATION MEDICINE & APPLIED SCIENCES
☐ SEIBERT, TYLER MICHAEL
   Primary Representative

RADIOLOGY
☒ BOLAR, DIVYA SANAM
   Primary Representative

☒ LIAU, JOY
   Primary Representative

RADY SCHOOL OF MANAGEMENT
☒ GNEEZY, AYELET
   Primary Representative

☐ MISRA, KANISHKA
   Alternate Representative
SIO
☒ ALFORD, MATTHEW H  
Primary Representative
☒ HILDEBRAND, JOHN A  
Primary Representative
☐ VAN ALLEN, EMILY JOYCE  
Primary Representative
☐ AARONS, SARAH MIRANDA  
Alternate Representative

SEVENTH
☒ PORTER, GEORGE  
Primary Representative
☒ VOGL, TOM  
Primary Representative
☒ POMEROY, ROBERT  
Alternate Representative
☐ WANG, EDWARD  
Alternate Representative

SOCIOLOGY
☐ RONA-TAS, AKOS  
Primary Representative
☐ LAMPLAND, MARTHA  
Alternate Representative

SSPPS
☒ MOMPER, JEREMIAH D  
Primary Representative
☒ DORRESTEIN, PIETER C  
Alternate Representative

STRUCTURAL ENGINEERING
☒ CHEN, JIUN-SHYAN  
Primary Representative
☒ TSAMPRAS, GEORGIOS  
Alternate Representative

SURGERY
☒ HORGAN, SANTIAGO  
Primary Representative
☐ FRIEDMAN, RICK ADAM  
Alternate Representative
☐ WATSON, DEBORAH  
Alternate Representative

THEATRE & DANCE
☒ BARRICELLI, MARC ALEXANDER  
Primary Representative
☐ BURELLE, JULIE SARA  
Alternate Representative
☒ POWELL, LORA  
Alternate Representative

URBAN STUDIES & PLANNING
☒ MARTIN, ISAAC WILLIAM  
Primary Representative

UROLOGY
☐ PARSONS, J KELLOGG  
Primary Representative
☐ BUCKLEY, JILL CHRISTINE  
Alternate Representative

VISUAL ARTS
☒ CHO, ERICA R  
Primary Representative
☒ ROSE, JORDAN M  
Primary Representative
☒ MANGOLTE, BABETTE MARIE  
Alternate Representative
☐ NEWSOME, ELIZABETH ANN  
Alternate Representative
ADVISORS

RESEARCH ADVISOR - GC
☐ GARUDADRI, HARINATH  ☒ GUPTA, AMARNATH
   Primary Advisor               Alternate Advisor

RESEARCH ADVISOR - HS
☐ KING, CHARLES  ☐ LI, SHENG
   Primary Advisor               Alternate Advisor

RESEARCH ADVISOR - SIO
☐ HAASE, JENNIFER  ☐ JOHNSTON, T.M. SHAUN
   Primary Advisor               Alternate Advisor

GRADUATE STUDENT ADVISOR
☒ WANG, VICTOR
   Primary Advisor

UNDERGRADUATE STUDENT ADVISOR
☒ HICKMAN, DAVID
   Primary Advisor
☒ GHARIBIAN, DEENA
   Primary Advisor
UC SAN DIEGO’S FINANCES
and RESPONSE TO THE PANDEMIC

November 30, 2020
Our Total Operating Budget is funded by five major sources, totaling $6.0 Billion (2020/21)

- Health System includes fully integrated clinical care, Medical Center, Physician Group and Population Health.
- Auxiliaries & Other includes Housing & Dining, Parking, Bookstore, Childcare, and other Educational Activities such as Aquarium, and Extension among others.

UC San Diego Operating Budget by Major Source

- Health System, $2.8B, 46%
- Contracts & Grants, $1.0B, 17%
- Core Budget, $1.5B, 25%
- Health System, $2.8B, 46%
- Gift Income, $0.2B, 2%
- Auxiliaries & Other, $0.6B, 10%

$6.0 billion total sources of funds
OPERATING BUDGET SOURCES

- **Core Funding** comes from Student tuition and fees, State appropriations in support of instruction, and Overhead from research. It is augmented by any net business incomes in order to subsidize the academic enterprise.

- **Externally Restricted Funding**
  - **Contracts and Grants** reflects direct contract and grants from external sponsors with a designated use to support research and innovation. It excludes indirect cost recovery or research overhead, which contributes to Core operating.
  - **Gift Income** represent campus gifts to The Regents. It excludes the university endowment, which reports separately on annual and campaign funds raised.

- **Separate Enterprises**
  - **The Health System** is a separate enterprise, funded by patient revenues. UC San Diego operates two medical hospitals, numerous clinics and urgent care locations across San Diego County.
  - **The Auxiliaries** are self-supporting units as mandated by State and Regental policy. They generate their own revenue sources by means of sales and services they provide to the campus and to the general public. They include housing, parking, bookstore, cultural venues and the extension school.
The Core segment of the budget is funded by four primary sources:

- **Core Funding**: $1.5B, 25%
- **Contracts & Grants Overhead**: $1.0B, 16%
- **Medical Center**: $2.8B, 46%
- **Gift Income**: $0.2B, 3%
- **State of California**: 21%
- **Non-Resident Tuition & Fees**: 24%
- **CA Resident Tuition & Fees**: 28%
- **Other Revenue**: 10%
- **Auxiliaries & Other**: $0.8B, 10%

*$1.5 billion total Core sources*
CORE BUDGET USES

73% of the Core Budget is allocated to the 3 Academics units

77% including Research and Student Affairs

UC San Diego Core Budget Uses

- Campus Operations, 23%
- Student Affairs, 2%
- Research Affairs, 2%
- Marine Sciences, 4%
- Health Sciences, 13%
- Academic Affairs, 56%

- Campus Operations includes buildings maintenance and operations, utilities, safety, information systems, business & finance functions, fundraising, compliance, and overall general administration.
COVID FINANCIAL IMPACT

The pandemic has 2 distinct impacts on the campus (excluding the Health System)

Core Budget
- $30M in permanent State funding cuts
- $25M one-time COVID-related expenses
  - Partly funded by $17M in CARES Act funding

Auxiliaries (Housing...)
- $92M one-time impact on housing from reduced 2020 and 2021 revenues
  - Another $38M if the pandemic extends in 2022
- $15M in recurring impact from permanent housing decompression
- $30M one-time impact to other auxiliaries (Parking, Bookstore, Aquarium...)

Primarily Recurring
Primarily one-time
FINANCIAL RESPONSE – CORE BUDGET

Impact is recurring, therefore our response had to be structural:

- **Compensation Freeze**: for non-represented staff and academics – *implemented*
  - Represented Staff received increases as per union agreements

- **Permanent budget cuts**: 4% across all operations, mostly delivered through attrition and strict position control - *implemented*
  - Freeze on staff hiring
  - Most faculty searches on hold despite record enrollment (1,000 more students this fall over 2019)

- Minimize discretionary expenses (travel, other)

Also:

- **Deferral of capital projects**: $1.7B capital projects deferred (Pepper Canyon West Housing, Triton Pavilion, ...) – *implemented*
FINANCIAL RESPONSE – AUXILIARIES

Impact is deep but mostly one-time, our response was 2-prong through FY21:

• **Operating loan:** $200M at 2% rate – *implemented*
  - Annual interest payments beginning in 2025

• **Ability to repay:** expenses reduced to absorb loan repayment terms. Actions include efficiencies (e.g. cashless operations, administrative consolidations, use of technology and CRM tools) and reduced spending on small capital improvements – *implemented*
WORKFORCE STRATEGIES

Hiring freeze to avoid lay-offs

• Around 370 positions eliminated in response to budget cuts or permanent business adjustments
• Primarily achieved through vacancies/attrition (strict position control in place since April) and redeployments
• Chancellor commitment to no COVID driven lay-off until the end of the fiscal year (June 30, 2020)
IN SUMMARY

- **State cut** is a severe negative impact

- **Record enrollment and record applications** need new investments in addition to restoring the budget cut to maintain academic excellence

- UC San Diego’s response to the pandemic has been comprehensive and proactive
  - Early, strict position control has enabled budget reductions to be accomplished with very limited social impact
  - Comprehensive **Return to Learn Strategy** and significant, early investments in testing and population health have enabled the campus to offer a residential experience to more than 9,000 students this fall with positivity rates in the 0.1%-0.4% range, much less than the County
### RETURN TO LEARN

The Return to Learn program is a science driven, multi-layered strategy designed around three adaptive pillars that promote on-campus safety:

#### Viral Detection
- Asymptomatic/Symptomatic Testing
- Environmental Monitoring
- Data Modeling
- Molecular Sequencing

#### Intervention
- Students with COVID-19 are provided support and a place to isolate, and robust contact tracing notifies employees and students who had close contact with someone who tested positive as quickly as possible.
- Contact Tracing
- Exposure Notification
- Case Isolation
- County Surveillance

#### Risk Mitigation
- Requiring face coverings, using personal protective equipment, enhancing sanitation, and lowering campus population density to reduce the risk of transmission.
- Face Covering/ Distancing
- Structural Reconfiguration
- Cleaning and Sanitation
- Airflow Reconfiguration
RETURN TO LEARN IMPACT

Leading campus outcomes
• Large scale asymptomatic, self-collection student testing program: Test kits freely available in vending machines and “grab and go” locations around campus
• Multiple Health System drive-up testing locations
• Integration with EPIC and Daily Symptom Screener
• Launch of California COVID Notify
• Supporting San Diego County contact tracing
• Supporting San Diego Unified School District and other school districts in San Diego County

Fall Quarter
• ≈9,300 Students in residence on campus
• 606 isolation and quarantine beds available
• 400+ Triton Health Ambassadors
• ≤ 0.4% 7 day average on-campus student test positivity rate
• 50 on-campus students positive since October 1
• 85 off-campus students positive since October 1
• ≈17 hour average PCR test result time
• 12,000 tests/day capacity and 2 CLIA labs
• 52 wastewater samplers deployed
Enrollment:

- Spring remained at full enrollment; Summer was 50% above usual
- Record Fall enrollment >40,000 students (remote & hybrid)
  - 5,600 Undergrads taking at least one in-person course, of whom 3,600 live off-campus
  - 1,000 Grad students taking at least one in-person course
  - 15,000 students with some campus presence each week

Classrooms

- Reconfigured indoor classrooms and limited class sizes to 25% of room capacity, capped at 50 students
- 4 outdoor classrooms for 50-75 students each, with WiFi, power, A/V already in use; more being planned for Winter
- Faculty working with The Commons to create fully online courses
- Senate/Admin workgroup on Distance Education empaneled
Leading Research outcomes

- Comprehensive Research continuity plan developed in May 2020
  - 6,100 members of campus research community covered by approved plans as of October 30, 2020 (≈25% density)

- Grants and awards
  - Record $1.45B in research awards in FY 19/20
  - FY21 Q1 highlights:
    - Proposal submissions in dollars up 62% and exceeded $1B in a quarter for the first time
    - Number of proposal submissions up 41%
  - Overall, UC San Diego has submitted 440 COVID proposals and received $28.9M in COVID related awards with a significant number focused on vulnerable communities

- Amaro Lab: Special Gordon Bell Prize for High Performance Computing-Based COVID-19 Research

- Research teams across campus creating apps, rapid prototyping products, and assessing behavior drivers, all in an effort to support the health and well being of our campus and community
**Leading Community outcomes**

- Advising, consulting, and sharing best practices:
  - Daily consultations with San Diego county
  - Hundreds of discussions with businesses, governments, and non-profits
  - Student leaders sharing with peers at other universities
- COVID testing support:
  - Free testing for all off-campus UC San Diego students and employees
    - Low fee testing for off-campus family members
  - Fee based testing for 25+ non-profits and businesses
- Business safety, continuity and recovery planning
  - Rady School of Management supporting business, financial, and recovery planning
  - Earth2 crowdsourced solutions to COVID related medical, health, and well-being issues
COVID-19 Daily Dashboard

UCSD Health Coronavirus (COVID-19) Daily Readiness

**Amb Arrived Visits**
- Date: 11/30/2020
- Number: 4,559
- MyChartVV Rate: 23%

**ED Visits**
- Effective Date: 11/30/2020
- Number: 240

**Average Daily Census**
- Effective Date: 11/30/2020
- Number: 663

**Nurse Sick Calls**
- Work Date: 11/30/2020
- Number: ▲59

**Available Lic ICU Beds**
- Census Date: 11/30/2020
- Beds: ▼5
- Total ICU Beds: 112

**TOTAL Ventilated Pts**
- Record Date: 11/30/2020
- Pneumonia Ventilators: ▲47
- Total Ventilators: 136
  - COVID: 13
  - Non-COVID: 123

**Final Results: Health & Students**
- Result Date: 11/30/2020
- Total Final Results: 3,167
- Positive Results: Including 13 COVID Cleared Inhouse 2 Additional PUI Inhouse ▲58
- Inhouse COVID Pts through Census Date: 11/30/2020: ▼52
- Through 11/30/2020: 655
  - 581 Alive, 74 Deceased

**Total COVID/PUI Pts Inhouse by Level of Care**
- As of Census Date: 11/30/2020

**KPI Notes:**
- All trend lines under KPI widgets display last 8 weeks of data.

---

**PPE Status**
- As of 11/30/2020
- Status: Green

**OR Suite Cases**
- Date: 11/30/2020
- Number: 121

**Procedural Area Cases:**
- Number: 158

---

**ICU Beds Available by Department**
- Date: 11/30/2020
- Department
  - TH 2-CVICU: 1
  - SC 3-AICU: 1
  - JM 3H-ICU: 1
  - JM 3F-ICU: 1
  - HC 2-SICU: 1
COVID-19 County Hospitalization Statistics

San Diego County Hospitalizations
April 11 – November 30, 2020

Imperial County Hospitalizations
April 11 – November 30, 2020
How well is the UCSDCOVIDReadi model performing? Forecast from 11/20

San Diego County COVID-19 Hospitalizations

- Calibrated up to here
- Forecast

San Diego County COVID-19 ICU

- Calibrated up to here
- Forecast
Updated UCSDCOVIDReadi forecasts 11/28

San Diego County COVID-19 Hospitalizations

San Diego County COVID-19 ICU
Pfizer Vaccine

- Pfizer-BioNTech
- mRNA vaccine
- 2 doses, 21 days apart
- Requires ultra-low temperature storage (-80°C)
- Shipped from Pfizer to administration/storage sites
- May be the first vaccine distributed (~December)
Moderna Vaccine

- mRNA vaccine
- Two doses, 28 days apart
- Requires frozen storage (-20° C)
  - The range (-25° to -15° C) is narrower than other frozen vaccines
- Shipped to administration/storage sites from McKesson
- Ancillary supplies shipped by USG
- Expected to be released closely behind Pfizer
Practical Numbers

- CA to receive 327,000 doses (to vaccinate 164,000 people) of Pfizer vaccine in December.
- No word yet on Moderna.
- There are 2.4 million HCW in CA
ACIP Phase 1

Work Group Proposed Interim Phase 1 Sequence

- Phase 1a
  - HCP
  - LTCF residents

- Phase 1b
  - Essential workers
    (examples: Education Sector, Food & Agriculture, Utilities, Police, Firefighters, Corrections Officers, Transportation)

- Phase 1c
  - Adults with high-risk medical conditions
  - Adults 65+
# DRAFT TIER 1: Highest Risk

Front line patient-facing staff with exposure to patients COVID-19 or treating high risk patients for complications.

<table>
<thead>
<tr>
<th>ACUTE CARE</th>
<th>AMBULATORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. ED/Trauma/STEMI/Stroke/L&amp;D</td>
<td>1. Urgent Care (includes COVID-19 testing sites)</td>
</tr>
<tr>
<td>2. Respiratory Therapy</td>
<td>2. Express Care</td>
</tr>
<tr>
<td>3. Intensive Care Units (including burn) and COVID Units</td>
<td>3. Primary care IM, FM, Geriatrics, pediatrics, Owen</td>
</tr>
<tr>
<td>4. Behavioral Health Units</td>
<td>4. Infusion center</td>
</tr>
<tr>
<td>5. Onc / BMT / SOT Units</td>
<td>5. COVID Clinical trials staff</td>
</tr>
<tr>
<td>6. Anesthesia</td>
<td>6. Apheresis / Outpatient Dialysis</td>
</tr>
<tr>
<td>7. Procedural Areas (IR, GI, Pulmonary, Cardiology)</td>
<td></td>
</tr>
<tr>
<td>8. Acute Dialysis</td>
<td></td>
</tr>
<tr>
<td>9. EVS / Security</td>
<td></td>
</tr>
<tr>
<td>10. Medical Surgical Units (Hospitalists, Nurses, Staff etc)</td>
<td></td>
</tr>
<tr>
<td>11. Surgery</td>
<td></td>
</tr>
<tr>
<td>12. Pharmacists in code blues</td>
<td></td>
</tr>
<tr>
<td>13. PT/OT</td>
<td></td>
</tr>
<tr>
<td>14. Radiology technicians</td>
<td></td>
</tr>
<tr>
<td>15. Lab/Phlebotomists</td>
<td></td>
</tr>
<tr>
<td>16. Inpatient pharmacy staff</td>
<td></td>
</tr>
<tr>
<td>17. Transporters, Translators, Chaplains</td>
<td></td>
</tr>
<tr>
<td>18. Consulting specialties</td>
<td></td>
</tr>
<tr>
<td>19. Facilities engineering (plumbers, electricians, HVAC)</td>
<td></td>
</tr>
<tr>
<td>20. Storehouse</td>
<td></td>
</tr>
</tbody>
</table>

# TIER 2: High Risk

Front line clinical staff who provide direct patient care and support staff with some risk of exposure, essential services to patient care.

<table>
<thead>
<tr>
<th>ACUTE CARE</th>
<th>AMBULATORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Clinical medical students and clinical pharmacy students (exclude visiting students)</td>
<td>1. Pulmonary</td>
</tr>
<tr>
<td>2. Food and nutrition services</td>
<td>2. ENT</td>
</tr>
<tr>
<td>4. Radiology Services</td>
<td>4. Cancer Center</td>
</tr>
<tr>
<td>5. Lab staff</td>
<td>5. Outpatient Lab</td>
</tr>
<tr>
<td></td>
<td>6. Pulmonary function lab</td>
</tr>
<tr>
<td></td>
<td>7. Cardiac Function Lab</td>
</tr>
<tr>
<td></td>
<td>8. Eating disorder</td>
</tr>
<tr>
<td></td>
<td>9. Speech Therapy</td>
</tr>
<tr>
<td></td>
<td>10. PT/OT</td>
</tr>
<tr>
<td></td>
<td>11. IR</td>
</tr>
<tr>
<td></td>
<td>12. Outpatient pharmacy</td>
</tr>
<tr>
<td></td>
<td>13. on call administrators (emergency preparedness etc)</td>
</tr>
<tr>
<td></td>
<td>UCSD Student Health Employees</td>
</tr>
</tbody>
</table>

ALL OTHERS IN HCW (Including IT, etc) AND HCW WHO HAVE NOT YET BEEN VACCINATED
Outline

Background: Data Science at UCSD
Coursework: Foundational
Coursework: Core Knowledge
Electives and Specialization Areas
Degree Requirements
Pathways to MS/DS
HDSI Faculty

- 24 faculty appointed: 11 full-time, 5 50%, 8 25%
  - Total of 47 faculty formally appointed and engaged.
- $5.5M in active grants, over 36 proposals submitted, 13 large-scale (>10M) integrative efforts.
UCSD major in Data Science (DS)

Undergraduate major offered since 2016.
Joint venture between CSE and Math Dept.
--- administered by HDSI since 2018.
First majors graduated in 2020 -- 50 in total
Currently there are 767 DS majors (all years)
--- plus over 200 minors
**MS programs popular nationwide**

Example: U of Michigan has strong Statistics Dept.
They are now in their third year running MS/DS
(Stats jointly with EE, CS and School of Information)
Last year, received 960 applications for a class of 50
Unique challenge

How to accommodate incoming students with different backgrounds:

1. Computing background
2. Math/Statistics background
3. Science background, e.g. Economics, Biology, etc.
Create 5 foundational graduate courses:

1. DSC 200: Data Science Programming
2. DSC 202: Data Management and Database Visualization Methods
3. DSC 210: Numerical Linear Algebra
4. DSC 211: Multivariable Calculus and Optimization
5. DSC 212: Probability and Statistics for Data Science

Having the relevant background, the student can opt out of some (or all) of the above—upon approval by the student’s faculty advisor.
Two required core courses:

1. DSC 240: Machine Learning
2. DSC 260: Data Ethics and Fairness
Further Core Knowledge and Skill Areas

Students also take at least 3 of the 7 core courses

1. DSC 203: Data Visualization and Scalable Visual Analytics
2. DSC 204: Scalable Data Systems
3. DSC 241: Statistical Models
4. DSC 242: High-dimensional Probability and Statistics
5. DSC 243: Continuous Optimization
6. DSC 244: Large-Scale Statistical Analysis
7. DSC 250: Advanced Data Mining
DSC Elective Courses (partial list)

1. DSC 205: Geometry of Data
2. DSC 231: Embedded Sensing and IOT Data Models and Methods,
3. DSC 251: Machine Learning in Control: Estimation of stability and uncertainty, optimal control,
4. and sequential decision making
5. DSC 252: Statistical Natural Language Processing
6. DSC 253: Advanced Data-driven Text Mining
7. DSC 254: Statistical Signal and Image Analysis
8. DSC 213: Statistics on Manifolds
Electives and Specialization Areas

CSE/Math/CogSci Elective Courses (partial list)

1. CSE 234: Data Systems for Machine Learning
2. MATH 281ABC. Mathematical Statistics
3. MATH 284. Survival Analysis
4. MATH 285. Stochastic Processes
5. MATH 287A. Time Series Analysis
6. MATH 287B. Multivariate Analysis
7. COGS 243: Statistical Inference and data analysis
Electives and Specialization Areas

The program also provides for specializations engaging several different departments/units.

Examples of specialization areas:

1. Bioengineering
2. Business (Marketing, Finance, etc.)
3. Machine Vision and Interaction Design
4. Computational Neuroscience
5. Networks
Electives and Specialization Areas

Additional specialization areas may include:

1. Design
2. Civil Society and Public Policy
3. Environmental Data Science
4. Cyber-Physical Systems
5. Automation and Control
6. Biomedical Informatics.
7. etc.
Requirements for the MS/DS

1. 48 units (12 courses) are required
2. Out of the 12 courses, at least 10 must be graduate-level (including foundational courses)
3. At most two can be upper-level undergraduate
4. In addition, two out of the 10 graduate courses can be courses in areas not directly related to data science, e.g., economics, biology, medicine, etc. upon approval of the student’s faculty advisor.
Two paths for the MS/DS

1. **Thesis Option**: the student must sign up for a minimum of 8 and maximum of 12 units of DSC 299 (Independent Research)

2. **Course-Directed Comprehensive Examination Option**: the student will be tested in three course-hosted comprehensive examinations, each in a different subject area.
Examples of paths for the MS/DS

Student A with background in Computing/Information

Fall 1: DSC 210, 211, 240
Winter 1: DSC 212, 241, 242
Spring 1: DSC 243, 244, COGS 278 + Comp Exam
Fall 2: DSC 260, COGS 280, 283
Examples of paths for the MS/DS

Student B with background in Mathematics/Statistics

Fall 1: DSC 200, 240, 260

Winter 1: DSC 202, 241, 242, MATH 287A,

Spring 1: DSC 204, 244, MATH 287C + Comp Exam

Student transfers MATH 185 and 189 having taken them beforehand (not used towards B.S.).
Examples of paths for the MS/DS

Student C with Domain Specialization Background

Fall 1: DSC 200, 210, 211
Winter 1: DSC 202, 212, 250
Spring 1: DSC 298, 204, 244
Fall 2 DSC 298, 240, 260
Winter 2: DSC 298 -- Thesis Option.
Master of Data Science
A Brief Overview of
Online Program Proposal

Leo Porter, Associate Teaching Professor, CSE and HDSI Founding Member
Jingbo Shang, Assistant Professor, CSE and HDSI
Needs of Working

- Data science is a growing field that is in high demand from industry and students
- An Online Master of Data Science (MDS) allows working professionals to learn new skills
- Leverages UCSD’s strengths in HDSI, CSE, Design Lab, CogSci, ECE, SDSC, and other related fields as well as our experience with the in-person MAS in Data Science
National and Local Context

- UC Berkeley, UC Riverside, University of Illinois at Urbana Champaign, Georgia Tech, UT Austin, U Michigan all have online Data Science or Computer Science degrees
- Almost all UCs have online degrees
  - UCB and UCR have online Data Science Master’s Degrees
- MDS (online): 2nd online degree at UCSD
  - Previous program approved by the AS in June 2020
- UCSD has a successful “MicroMasters” in Data Science on edX
MS DS and MDS (online)

- **MS/DS:** standard in-person MS degree
- **OMDS:**
  - Addresses the needs of working professionals
    - Content focuses on topics relevant working professionals
  - Allows students to progress at their own pace
  - Anticipate different student demographics
    - Older professionals and more global audience
  - Lower cost ($22k vs. ~$35 resident/~$66k non-resident)
Diversity Impact

Key features:
- Lower cost entry point through MicroMasters
- Self-paced MicroMasters allows for students to take additional supporting courses before starting
- Intentional recruitment of students from diverse backgrounds
  - Reaching out to schools, recruiting at Tapia/Grace Hopper
  - Holistic Admissions
- Course development follows Quality Matters
- Leverages CSE’s active DEI committee
- 25% of profits will be used to fund diversity fellowships and initiatives.
Program Details

- Ten 4-unit quarter-length courses including:
  - Foundation courses (3 required)
  - Core courses (3 required)
  - Elective courses (pick any 3 required)
  - Capstone course (1 required)
Foundations (3 courses)

- MDS 200R: Python for Data Science
- MDS 210R: Prob/Stats in Data Science using Python
- MDS 220R: Machine Learning Fundamentals

Raw Data → Prep → Store → Math → Analyze → Visualize

- Python
- Jupyter
- Pandas
- Prob and Stats
- Theory of Machine Learning

Core (3 courses)

MDS 230R: Big Data Analytics Using Spark
MDS 240R: Data Mining on the Web
MDS 250R: Data Management for Analytics

- Raw Data → Prep → Store → Analyze → Visualize
- Cloud Storage
- Scalability using Spark
- Applications of ML & Data Mining
- Data mining
- Big Data Storage & OS support
- Scrape & Prepare Data
- Spark
Electives (pick 3)

- MDS 260R: Advanced Unsupervised Learning
- MDS 261R: From Data to Products
- MDS 262R: Data Visualization
- MDS 263R: Data Preprocessing
- MDS 264R: Interaction Design

Electives (any 3)

- Concepts of Data Vis
- D3.js & Tableau
- Data Extraction, Transformation and Loading into a Storage System
- User Interface Design for entire pipeline

Data Flow:
- Raw Data → Prep → Store → Analyze → Visualize
- Unsupervised & Deep Learning
- Python
- Addressing challenges at all levels related to putting ideas into production
- User Interface Design for Visualization
Capstone

Raw Data → Prep → Store → Analyze → Visualize → Math
Questions
# Courses

<table>
<thead>
<tr>
<th>Foundation (all 3)</th>
<th>Core (all 3)</th>
<th>Electives (any 3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDS 200R: Python for Data Science</td>
<td>MDS 210R: Prob/Stats in Data Science using Python</td>
<td>MDS 260R: Advanced Unsupervised Learning</td>
</tr>
<tr>
<td>MDS 220R: Machine Learning Fundamentals</td>
<td>MDS 230R: Big Data Analytics Using Spark</td>
<td>MDS 261R: From Data to Products</td>
</tr>
<tr>
<td>MDS 240R: Data Mining on the Web</td>
<td>MDS 240R: Data Mining on the Web</td>
<td>MDS 262R: Data Visualization</td>
</tr>
<tr>
<td>MDS 250R: Data Management for Analytics</td>
<td></td>
<td>MDS 263R: Data Preprocessing</td>
</tr>
</tbody>
</table>

**Analysis and Visualization**

- Raw Data
- Prep
- Store
- Analyze
- Visualize

**Courses**

- **Python and Jupyter**
- **Prob and Stats**
- **Theory of Machine Learning**
- **Cloud Storage**
- **Big Data Storage & OS support**
- **Unsupervised & Deep Learning**
- **Python**
- **Application of ML & Data Mining**
- **Scrape & Prepare Data**
- **Data mining**
- **Addressing challenges at all levels related to putting ideas into production**
- **Data Extraction, Transformation and Loading into a Storage System**
- **User Interface Design for entire pipeline**
- **Putting all the pieces together into a single large project**

**Specialties**

- Python Jupyter
- Python Jupyter
- Python Jupyter
- Cloud Storage
- Scalability using Spark
- Applications of ML & Data Mining
- Unsupervised & Deep Learning
Demographics

- Students attracted to our introductory class on edX:
  - Median Age: 28  → 51% are 26-40yrs old
  - 46% have bachelor’s, 34.1% have advanced degree
  - 24.6% women (18% is average for CS nationally)
  - From 156 countries - 22% from US, 14% India, 4% Canada
Educational Quality

● Teaching Excellence Coordinator
  ○ Has experience building online courses
  ○ Oversees the course design process
  ○ Works with TLC to ensure “Quality Matters” standards are achieved
● Leveraging campus experience experience
Academic Integrity

- Software Secure and ProctorU well accepted in online education (and peer institutions) for exams
- Use of Moss (or similar tools) for assignments
- Design of courses to ensure frequent assessments
  - Following “Quality Matters” recommendations from TLC
Other UCSD Programs

- In-Person MAS in Data Science
- In-Person MS in Data Science (just presented)
- ECE MS with Specialization in Data Science
Students w/Disabilities

- All courses will meet the Electronic Accessibility standards established by UCOP.
- Students can seek accommodations to the UC San Diego Office for Students with Disabilities.
- In addition, the courses will all include the following:
  - All videos will have captions.
  - All videos will be accessible for screen readers
  - For students who need additional accommodation, voice navigation and voice dictation will be available upon request
  - Care will be taken by instructors to avoid using colors to signify or promote particular actions to accommodate students with color blindness
  - All online materials will have the ability to have the font sizes increased
  - Course text (pdfs, other documents) will also be accessible
Other UC Programs

- UCB - online MS programs including online MS in data science
- UCR - online MS programs including an MS in Engineering with specializations (one of which is in Data Science)
- UCLA - online MS in engineering with multiple specializations
- UCI - online MS programs in Criminology and Forensic Psychology
- UCD - online MBA
- UCSF - online MS programs in Nursing and Public Health
Other National Programs

Some Related Online MS degrees in CS and/or Data Science

● Georgia Tech
  ○ Pioneered online degrees in CS and Analytics.
  ○ Running for nearly a decade.

● UIUC
  ○ Online MS of CS in Data Science
  ○ Has been there for 2 or 3 years

● UT Austin online MS in Data Science through edX

● Johns Hopkins online MS in Data Science
Onload/Offload Teaching

• Combination of Onload/Offload based on program and instructor needs
  ○ First few years, goal is to have 40% onload teaching by senate faculty
Timeline

- Goal is to announce: Spring 2020
- First cohort: Fall 2021

Timeline subject to modification based on approval process, course development progress, and UCSD online infrastructure progress.
<table>
<thead>
<tr>
<th>Event</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposal submitted for UCSD approval</td>
<td>June 2020</td>
</tr>
<tr>
<td>Proposal submitted to CCGA</td>
<td>October 2020</td>
</tr>
<tr>
<td>CCGA Approval (UC-level approval)</td>
<td>December 2020</td>
</tr>
<tr>
<td>WSCUC Approval (Accreditation agency)</td>
<td>March 2021</td>
</tr>
<tr>
<td>Applications Accepted</td>
<td>March-June 2021</td>
</tr>
<tr>
<td>Admissions of first Cohort</td>
<td>August 2021</td>
</tr>
<tr>
<td>Program Offered</td>
<td>October 2021</td>
</tr>
</tbody>
</table>
Budget

● Cost for Students: $22,000 total
  ○ Can try courses in the MicroMasters for $350 each or $1400 for all four

● UCSD expenses:
  ○ Course development, maintenance, and offerings
  ○ TA support
  ○ Staff support

● At 500 students per year
  ○ MDS anticipates ~$4.3M annual income
  ○ UCSD anticipates ~3.5M annual income
### Refunds

<table>
<thead>
<tr>
<th>% Refund if drop during ...</th>
<th>MDS</th>
<th>UCSD in Person</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week 1</td>
<td>100%</td>
<td>90%-100%</td>
</tr>
<tr>
<td>Week 2</td>
<td>100%</td>
<td>50%</td>
</tr>
<tr>
<td>Week 3</td>
<td>70%</td>
<td>25%-50%</td>
</tr>
<tr>
<td>Week 4</td>
<td>60%</td>
<td>25%</td>
</tr>
<tr>
<td>Week 5</td>
<td>50%</td>
<td>0%-25%</td>
</tr>
<tr>
<td>Week 6</td>
<td>40%</td>
<td>0%</td>
</tr>
<tr>
<td>Week 7</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td>Week 8</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td>Week 9</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td>Week 10</td>
<td>0%</td>
<td>0%</td>
</tr>
</tbody>
</table>
Success Metrics

- Metrics:
  - Course Completion Rate (80-85%)
  - Graduation Rate (80-85%)
  - Graduate Employment
  - DEI
  - Student, TA, Instructor Surveys
  - Financial Health of the Program

- Digital Learning Hub (TLC) will aid in the assessment
Foundations (3 courses)

Foundations (all 3)
- MDS 200R: Python for Data Science
- MDS 210R: Prob/Stats in Data Science using Python
- MDS 220R: Machine Learning Fundamentals

Raw Data → Prep → Store → Math → Analyze → Visualize

- Python
- Jupyter
- Pandas
- Prob and Stats
- Python
- Jupyter
- Theory of Machine Learning
- Python
- Jupyter
Core (3 courses)

- MDS 230R: Big Data Analytics Using Spark
- MDS 240R: Data Mining on the Web
- MDS 250R: Data Management for Analytics

Flow:
- Raw Data → Prep → Store → Analyze → Visualize

- Cloud Storage
- Scalability using Spark
- Applications of ML & Data Mining
- Data mining
- Big Data Storage & OS support
- Scrape & Prepare Data
- Spark
Electives (pick 3)

- MDS 260R: Advanced Unsupervised Learning
- MDS 261R: From Data to Products
- MDS 262R: Data Visualization
- MDS 263R: Data Preprocessing
- MDS 264R: Interaction Design

Raw Data → Prep → Store → Analyze → Visualize

- Unsupervised, & Deep Learning
- Python
- Addressing challenges at all levels related to putting ideas into production
- Concepts of Data Vis
- D3.js & Tableau
- Data Extraction, Transformation and Loading into a Storage System
- User Interface Design for entire pipeline
- User Interface Design for Visualization
Capstone

Raw Data → Prep → Store → Analyze → Visualize

Math
Foundations (3 courses)

- MDS 200R: Python for Data Science
- MDS 210R: Probability and Statistics in Data Science using Python
- MDS 220R: Machine Learning Fundamentals
Core (3 courses)

- MDS 230R: Big Data Analytics Using Spark
- MDS 240R: Data Mining on the Web
- MDS 250R: Data Management for Analytics
Electives (pick 3)

- MDS 260R: Advanced Unsupervised Learning
- MDS 261R: From Data to Products
- MDS 262R: Data Visualization
- MDS 263R: Data Preprocessing
- MDS 264R: Interaction Design
- (with more to come)
MDS 298R: Capstone Project in Data Science
- Students select several projects from multiple domains including Music, Oceanography, Computer Vision
Proposal to Amend Appendix II of the Senate Manual: UCSD Policy on Integrity of Scholarship

Geoffrey Cook, Chair
Educational Policy Committee
Resolution of Multi-student cases (Section II.B)

• **Proposed Change:** Allow flexibility to assign multi-student cases from different units to one Appropriate Administrative Authority (AAA) or multiple AAAs when determined appropriate to avoid delays in case resolution.

• **Current Policy:** All multi-student cases are assigned to one AAA.
Grade Holds (Section III.J)

• **Proposed Change:** Clarify that a “hold” on a grade once an Instructor files an Intent to Report or Allegation Report prevents a student from making any changes to a course (e.g. change grading options or units).

• **Current Policy:** States that a student may not withdraw if they are assigned a grade hold due to a pending AI allegation.
Holds on Transcripts, Admission, Awarding Degrees and Registration (Section III.O; *new*)

- **Proposed Change:** Add a new section to state that holds on student accounts may be used as a method for enforcing the AI Policy and its procedures.

- **Current Policy:** Not addressed in the current policy.
Department of Neurological Surgery Proposal

Alexander A. Khalessi MD MBA
Chair of Neurological Surgery
Professor of Surgery, Radiology and Neurosciences
Designation as a School of Medicine academic department represents a natural progression that will:

1. Recognize our position as a top neurosurgical department nationally

2. Allow formal UCOP recognition of planned Neurological Institute

3. Facilitate adjunct academic appointments that will allow greater institutional level collaboration

4. Contribute to the recruitment and retention of leading faculty through independent promotion processes

5. Maintain current positive trajectory in volume, impact, and visibility

6. Improve philanthropic position for dedicated endowed chairs and research funds

7. Mirror neurological surgery standing at sister UC and peer institutions

He who studies medicine without books sails an uncharted sea, but he who studies medicine without patients does not go to sea at all.
Neurological Surgery Resources

Jacobs Medical Center
A 245-bed advanced medical center that serves as a flagship hospital of UC San Diego Health and a primary teaching hospital for the UC San Diego School of Medicine. Home to two intraoperative MRI suites and two CT suites.

UC San Diego Health is home to:
• Two Comprehensive Stroke Centers
• The region’s only NCI-designated Comprehensive Cancer center
• Level 4 Epilepsy Center
• The region’s first Level I Trauma Center
• Nationally Ranked Pediatric Neurological Surgery Division at Rady Children’s Hospital

Altman Clinical & Translational Research Institute
Advancing scientific discovery to improve health – bringing discoveries from bench to bedside

T. Denny Sanford Medical Education and Telemedicine (MET) Building
Home to the Center for the Future of Surgery with Auditorium Seating for 350 guests

Center for the Future of Surgery
Where surgeons and scientists are advancing surgical techniques by investigating, developing, testing, and teaching procedures that will revolutionize the field of surgery
$10,776,123.60
TOTAL $ AMOUNT IN COMBINED NIH AND INDUSTRY GRANTS FOR FY19/20

671
TOTAL # OF MAJOR PEDIATRIC CASES

3,195
TOTAL # OF SURGICAL CASES, FY19/20

70
TOTAL # FACULTY PUBLICATIONS

#22
RANKING IN USNWR **TOP 25

UC San Diego Health System
Surgical Sciences and Modern Medical Progress

- Biological Implications of Intervention
  - Physiology and Natural History

- Procedural Advancements
  - Devices
  - Imaging and Visualization
  - Operative Technique

- Health Services Research
  - Meta-Analyses/Randomized Trials
  - Population-Based Data Applied to an Individual Case

- Systems Engineering, Processes of Care, and Surgical Training
Surgical Innovation: Device Technology Assessment

Necessary

- Competing Natural History
- Standard of Care Alternatives
- Unmet Clinical Need

Sufficient

- Full Complement of Alternatives
- CEC/DSMB and FDA Process
- Innovative Care Policy (MCP 383.3 / IRB)
- Biomedical Engineering and Iterative Design Application

...May I always act so as to preserve the finest traditions of my calling and may I long experience the joy of healing those who seek my help.
Research

• Intermediate Department research objectives include:
  • Brain tumor SPORE grant
  • Agility Center for Engineering
  • R25 Training grant with Neurosciences

• Neurological Surgery faculty currently support:
  • U01 grant for StrokeNet
  • U01 grant for Auditory Brainstem Implants
  • Lead key trials administered by the Alpha Stem Cell Clinic

• Neurological Surgery will play a key role in the T. Denny Sanford $100M gift to study the neurobiology of empathy and compassion.

• Neurological Surgery is also poised to partner with the Department of Neurosciences in dispensing the net of the University of Southern California-Alzheimer’s settlement for neurodegenerative disease (of a $50M total) upon Chancellor’s approval.

• Eventually, these collaborative research efforts will be housed in a freestanding Neurological Institute.
Education

- **Our residency program has experienced a ten-year period of outstanding stability and improvements**

- **The program has been recognized for its outstanding academic accomplishments by being granted a rare increase in the number of resident positions in 2011, as well as a current maximum 10-year accreditation from the ACGME with no major citations.**

- **Several faculty and residents have been recognized with teaching awards and have provided significant mentorship in research.**
  - Drs. Hoi Sang u, Jeffrey Steinberg and David Santiago-Dieppa have been awarded the Kaiser Excellence in Teaching Award in Surgery.
  - Drs. William Taylor and Joseph Ciacci have been awarded Resident Teaching Awards.
  - Dr. Alexander Khalessi received the Golden Suture award from Neurological Surgery Residents.

- **UC San Diego Neurological Surgery has led in national neurosurgery educational initiatives as part of the Society of Neurological Surgeons Residency Boot Camp Courses since their inception, and continues to serve on the committee for neurosurgery resident education courses at the national level.**

- **UC San Diego Medical Students Currently 4 Applying in neurosurgery**
**Philanthropy**

A key initiative in 2014 was the first Neurological Surgery faculty “giving campaign.” Neurosurgery faculty contributed $336,000 to the JMC Quad-Pod.

The Sharon B. and Lawrence F. Marshall, MD Presidential Chair in Neurosurgery.

The John Alksne, MD Endowed Visiting Professorship

By the end of FY19, it is anticipated that Neurological Surgery will be responsible for nearly $4.95M in donated equipment support from both new and existing industry partners.

**Fair Market Value of This Equipment Equates to Nearly $20M.**

It is anticipated that Neurological Surgery will raise nearly $5M in philanthropic support in fiscal year 2019. This would be a 253% increase over Neurological Surgery’s best philanthropic year ever.

**HOT OFF THE PRESS**

Don and Karen Cohn Chancellor’s Endowed Chair in Neurosurgery
akhalessi@health.ucsd.edu
Cell 310.906.6861
Department Strategic Plan-Neurological Surgery

• Clinical / Financial
  • Sub-Specialty Destination Programs and Advanced Certification Programs
  • Sustainable Expansion of Accretive Elective Cases and Payor Mix Refinement

• Regional Dominance and National Prominence
  • Engaged Optimization of Capital/Service Agreements, Patient Experience and Practice Management

• Faculty Compensation and Recruitment
  • Guaranteed Income, Productivity Incentives
  • Recruitment and Start-Up Management
  • COVID Mitigation Strategy

• Faculty Culture
  • Shared Governance, Transparency, and Engaged Citizenship

• Diversity Plan
  • Faculty and Resident Recruitment
  • Academic Work – ABNS Maternity Leave
  • HCOE, SURF, RISE, VC-EDI Peer Review Program

• Education
  • Strong Performance of Residency Program
  • Potential Complement Expansion
  • Enhanced Pipeline of UC San Diego Medical Students

• Research
  • Collaborative Research Dyads
  • Dedicated PhD post-Department
  • Engineering Partnership
  • Institute Platform

• Philanthropy
  • Center for Future Surgery - $20M In-Kind Support – Industry Opportunity
  • Endowed Chairs (Cohn and Marshall)
  • Institute Model
December 23, 2020

PROFESSOR STEVEN CONSTABLE, Chair  
Academic Senate, San Diego Division

SUBJECT: Winter and Spring 2021 Exceptions to San Diego Senate Policies

The Educational Policy Committee (EPC) met on December 15, 2020 to discuss a Resolution from the Associated Students calling on the Academic Senate to extend academic accommodations for Winter and Spring Quarters of the 2020-2021 year. Based on our discussions with the Committee’s undergraduate and graduate student representatives and the Deans of Undergraduate Education and the Graduate Division, it is clear that almost ten months after we first closed campus due to the pandemic, the situation has not become easier for our students. Learning in a remote environment is challenging, positivity rates are increasing with many students being directly or indirectly impacted by COVID-19, and the stress and uncertainty that our students are facing has not diminished since Spring 2020. In support of our students, EPC voted to approve accommodations to Senate policies for Winter and Spring 2021. EPC looks forward to working with you to advance these proposals to Representative Assembly for final approval.

EPC approved the following limited-term exceptions to San Diego Senate Regulations for Winter and Spring 2021:

1. A limited-term exception to SD Regulation 500.D.1 to exclude P/NP grades earned from the 25% limit on the number of courses that may be completed on a P/NP basis and allow students not in good academic standing to enroll in courses for a P/NP grade.

2. A limited-term exception to SD Regulation 500.D.2 to extend the deadline to change grading option (Letter or Pass/Not Pass grades) from the end of the fourth week to the end of the tenth week of instruction for undergraduate students.

3. A limited-term exception to SD Regulation 500.E.6 to extend the deadline to change grading option (Letter or Satisfactory/Unsatisfactory grades) from the beginning of the quarter (end of the fourth week, in practice) to the end of the tenth week of instruction for graduate students.

4. A limited-term exception to SD Regulations 501.B and 501.C to extend the deadline to drop a class or withdraw from the quarter with a “W” grade from the end of the sixth week to the end of the seventh week of instruction for undergraduate students.

5. A limited-term exception to SD Regulation 505.B to allow students to repeat courses with the P/NP or S/U grade option if previously taken for a letter grade.

EPC did not approve the following Associated Students request:

1. A limited-term exception to SD Regulation 501.A to extend the deadline to add a course to the end of third week of instruction.

EPC concluded that extending the deadline beyond the end of the second week of instruction could be problematic for students and instructors in many courses. An add deadline at the end of the third week equates to joining a course after 30% is completed. This has the potential to disadvantage students trying to catch up and make it difficult for instructors and TAs trying to help them catch up. In cases where it is reasonable to add a student after the Week 2 deadline, departments have the option to do so by petition.
EPC believes that granting these limited-term exceptions to San Diego Senate Regulations will provide students with necessary reassurance and increased confidence that they will be able to successfully navigate their academic careers during the pandemic.

Messaging has been consistent since Spring 2020—students are responsible for awareness regarding the impacts of exercising these options on their current and future academic, professional and personal endeavors. Decisions about whether to accept Pass (P) and Satisfactory (S) grades toward major, minor, general education and degree requirements remain at the discretion of the academic unit.

Thank you for considering EPC’s proposal. We hope that these accommodations will affirm the Senate’s commitment to our students’ success and well-being during this difficult and trying situation.

Sincerely,

Geoffrey Cook, Chair
Educational Policy Committee

cc: T. Javidi
R. Rodriguez
RESOLUTION CALLING FOR ACADEMIC SENATE TO EXTEND ACADEMIC ACCOMMODATIONS FOR WINTER AND SPRING QUARTER OF THE 2020-2021 YEAR

Whereas, The students at UC San Diego continue to feel the effects of the COVID-19 pandemic in their home and academic lives; and

Whereas, Students are still responding to unexpected developments in their health or the health of their families; and

Whereas, The United States is seeing record-breaking numbers of COVID-19 cases that have once again initiated lockdowns and curfews in many parts of California. Students are forced to readjust their personal and academic lives similar to how they adjusted to this shift in March 2020; and

Whereas, Other universities within the UC system with the exception of UC Santa Barbara, are offering academic accommodations with regard to the P/NP deadline and cap;

Resolved, that the Associated Students of UC San Diego (ASUCSD) call for the Academic Senate to exempt courses from 25% P/NP limit through the end of Week 10 for the Winter and Spring Quarters of the 2020-2021 Academic Year; and

Resolved, that the Associated Students of UC San Diego (ASUCSD) call for the Academic Senate to extend the P/NP deadline through the end of Week 10 for the Winter and Spring Quarters of the 2020-2021 Academic Year; and

Resolved, that the Associated Students of UC San Diego (ASUCSD) call for the Academic Senate to extend the “Add” deadline to the end of Week 3 for the Winter and Spring Quarters of the 2020-2021 Academic Year; and

Resolved, that the Associated Students of UC San Diego (ASUCSD) call for the Academic Senate to extend the drop with a “W” deadline to end of Week 7 for the Winter and Spring Quarters of the 2020-2021 Academic Year; and

Resolved, that the Associated Students of UC San Diego (ASUCSD) encourage students to meet with Academic Counselors to discuss the ramifications of utilizing these academic accommodations.
TO: Maripat Corr, Chair of the San Diego Divisional Academic Senate

FROM: Emily Roxworthy, Provost of Earl Warren College

RE: Request for amendments to the Bylaws of the Faculty of Earl Warren College

June 17, 2020

Dear Maripat,

The faculty of Warren College requests that the Academic Senate consider the following amendments to the Senate Regulation Appendix 5.4 (Bylaws of the Faculty of Earl Warren College, hereafter “Bylaws”) regarding the definition of a “quorum” and the governing bodies of the College:

1. Quorum: The distinction between faculty in residence and those not in residence is difficult to parse and no longer relevant, so Warren faculty voted to remove this distinction.

2. Committees: Changes were made to this section to clarify confusion between the two governing bodies; the larger body that includes elected faculty representatives alongside the provost and appointed staff and student representatives will now be called the “Warren College Steering Committee.” The “Executive Committee of the Faculty” has an elected chair (not the Provost) that provides advice to the Provost whereas the Steering Committee is chaired by the Provost and provides advice to the college staff.

The proposed amendments to the Bylaws are marked in the attached file A; the file B presents the unmarked revised version. Earlier this month, Warren Faculty voted on these amendments and the results of the electronic ballot (see file C) are:

Yes: 44
No: 0
Abstain: 1

Bylaws amendments require the presence of 20 percent of the membership or ten members of the faculty, whichever is the greater; therefore 45 faculty votes meets the requirement to proceed with Academic Senate final approval. Please let me know if you have any questions or concerns about these proposed changes. Thank you for your consideration.

Sincerely,

Emily Roxworthy, Ph.D.
APPENDIX V
BYLAWS OF THE FACULTY OF EARL WARREN COLLEGE

(Approved By The San Diego Division 4/30/74; Am 2/28/95, 10/23/06, 5/22/12)

I. MEMBERSHIP

All members of the San Diego Division of the Academic Senate appointed to Warren College are voting members of the Warren College Faculty.

II. FUNCTION

Under the rules of the Academic Senate and the San Diego Division, the faculty is responsible for the academic program and concerned with all aspects of the college that bear directly on that program.

III. FACULTY MEETINGS

Faculty meetings shall be called by the Provost as the need arises. Meetings can also be called by the Executive Committee or at the written request of ten members of the faculty. [Am 2/28/95]

IV. QUORUM

The presence of 20 members of the faculty in residence shall constitute a quorum.

V. COMMITTEES

The Executive Committee of the Faculty shall consist of an elected member from each of the undergraduate academic areas represented by a division, and the Provost, and they shall elect a Chair. The Provost may neither vote on nor serve as the Chair of the Executive Committee. This Committee shall serve as a steering committee an advisory body to the Provost in order to implement the function set forth in Paragraph II and shall have the power to appoint committees as needed. [Am 2/28/95, 10/23/06]

The elected faculty members of the Executive Committee of the Faculty also serve as faculty representatives in the Warren College Executive Committee to the Warren College Steering Committee, which also includes student and staff representatives and which is chaired by the Provost. The College Executive Committee advises the Provost-College Steering Committee provides more holistic advice on Warren College affairs. [Am 2/28/95, 10/23/06] Nominations for members of the Executive Committee of the Faculty shall be made by the faculty annually and shall be submitted for election by mail or electronic ballot. Elected Executive Committee members shall serve for two years. These
Executive Committee members shall also serve as Warren College representatives (or alternates) to the Academic Senate Representative Assembly. [Am 2/28/95]

VI. RULES OF ORDER

Robert's Rules of Order shall govern the transaction of business, except for modifications of these Bylaws or the Academic Plan of Warren College. The procedure for such modifications is stipulated in Bylaws VII and VIII.

VI. ACADEMIC PLAN

Changes in the Warren College Academic Plan shall be approved for submission to the Division by a simple majority vote at a Warren College faculty meeting or by anonymous mail or electronic ballots, as deemed appropriate by the Executive Committee of the Faculty, provided that the faculty has been notified of the meeting and the proposed change at least five days of instruction prior to the meeting. Mail or electronic ballots shall include arguments for and against any proposed changes.

VII. AMENDMENT OF BYLAWS

The procedure for amendment of these Bylaws shall be the same as for changes in the Academic Plan, except that a two-thirds majority is required. Faculty may be apprised of proposed amendments to the Bylaws via mail or electronic notification, and if no faculty member objects, amendments may be voted upon via anonymous mail or electronic ballot of the faculty as deemed appropriate by the Executive Committee of the Faculty.
December 18, 2020

Steven Constable, Chair
San Diego Divisional Academic Senate

SUBJECT: Amendment to Senate Manual Appendix 5.4, Bylaws of Earl Warren College

Dear Chair Constable,

The Committee on Rules and Jurisdiction reviewed the proposal to amend the Earl Warren College Bylaws and found the proposal consonant with the Code of the Academic Senate.

Sincerely,

Professor Geoffrey Braswell, Chair
Committee on Rules and Jurisdiction

cc: L. Hullings
    T. Javidi
    R. Rodriguez